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Summary

New Features

• Added ability to open source files in their source application via right click options

• Added ability to verify segments to make sure they are committed to TM

• Added ability to quickly open the location of all project resources via right click options

• Added ability to import and export bilingual MS Word files from Quick Tools

• Added ability to Export Bilingual MS Word files from the Project View

• Added ability to open project automatically after project creation

• Added ability to automatically store the source file in the Wordfast project folder

• Added new TM Lookup Information dialog box with penalty breakdown, penalty indicator, and
custom attribute support

• Added ability to open source files from the TXLF Editor view

Improvements

• Added multiple Smart Quote Improvements

• Added support to export notes for Chained Files

• Added support of bilingual tables for Chained Files

• Added new Table filter to show all segment except auto-propagated segments

• Added indicator to show when multiple term translations exist

• The TM Lookup panel can now be maximized without limit

• Added ability to archive files that are removed from a project

• Added Hunspell dictionaries for Bosnian, Croatian, Hindi, Slovak, and many other languages

• Added support for maximum paragraph length attribute to be used in Transcheck

• Added ability to use the TM configuration and penalization that is sent from PD

• When files are Chained, only modified files are updated in the Project View

• The Transcheck report now indicates when there are multiple term translations with purple
highlight

Fixed Issues

• Fixed multiple whitespace issues

• Fixed issue with pasting whitespaces into other applications

• Fixed issue where opening quotes should be entered after braces

• Fixed issue where NBSP character could not be added to Find/Replace

• Fixed several TXLF editor cursor focus issues

• Fixed Microsoft Surface installer issues
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• Fixed issue with Chain Files not indicating correct segment number in Notes
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About Wordfast Pro 1
Wordfast Pro is a translation and editing application designed to improve the way in which translators
work. It presents translators with a collaborative environment where Translation Memory (TM) files can
be accessed quickly and efficiently. Wordfast Pro is a flexible application that can work with desktop TM
files or interact directly with a powerful TM server application. It can also operate as a stand-alone tool to
supplement existing translation workflows.

Key Advantages

• TM compatibility: Tabular TM format allows for simple integration of Trados, SDLX or Déjà Vu TM
files.

• Format flexibility: Native format is TXLF, an XML-based pivot format. Filters exist for DOC, PPT,
XLS, PDF, HTML, MIF, INX, JSP, RC and TTX files. Wordfast supports only those TTX files that
are translated and segmented using tag editor.

• Collaborative environment: Users can interact with TM Server and share translation memory
assets in real-time.

• Automated editing: Multi-lingual spell checkers and terminology recognition improves the speed
and accuracy in the review process.

• Administrative security: Managers can assign specific rights and privileges to individual translators
or linguistic teams.
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Typical Wordfast Pro Workflow 2
The phase chart below describes a typical translation project workflow in Wordfast Pro.
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Getting Started 3
This chapter provides the basic information to get started in Wordfast Professional (Wordfast Pro).

Wordfast Pro is a desktop application and can be installed and accessed on your computer (refer to
Installing and Activating Wordfast Pro).

Requirements

Wordfast Pro requires the following:

• Java JRE. If not present, it is installed automatically during Wordfast Pro installation

• Activation of the full Wordfast Pro installation requires a license and registration

• Minimum RAM of 2GB

• Minimum resolution of 1366 x 768 is recommended

• Operating systems: Microsoft Windows 7 and 8, OSX 10.9+

Installing and Activating Wordfast Pro

To install and activate Wordfast Pro:

 1. Download the Wordfast Pro installer from the website http://www.wordfast.com/ to a local hard drive.

 2. Run the installer.

Wordfast Pro opens in Demo Mode.

To activate Wordfast Pro, a license must be obtained and registered either online or offline.

  Note:

Wordfast Pro demo mode provides an opportunity to view and try out the functions with limitations.

With an unlicensed Wordfast Pro working in Demo Mode, you are limited to creating bilingual
projects and storing up to 500 translation units in your Translation Memory.

 3. Activate your Wordfast Pro license through the website http://www.wordfast.com/.

An Activation Key is returned by email.

Refer to:

• Online Activation

• Offline Activation

Online Activation

When you activate Wordfast Pro online you are emailed an Activation Key.

http://www.wordfast.com/
http://www.wordfast.com/
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To begin:

 1. Open Wordfast Pro.

 2. Click the Help tab.

 3. Click License Management.

 4. Click Online Registration.
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 5. Enter the activation key you were emailed into the Activation Key field.

 6. Click OK.

 7. Restart Wordfast Pro.

Your Wordfast Pro installation is now activated.

  Note:

To resolve any license issues, log in to Wordfast Pro and select Support > Hotline.

Offline Activation

If you need to activate Wordfast Pro offline, a License file is emailed to you. Save this license file to a
known location on the computer where Wordfast Pro is installed.

To activate Wordfast Pro offline:

 1. Open Wordfast Pro.

 2. Click Help.

 3. Click License Management.

 4. Click Manual Registration.
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 5. Enter the activation key in the Activation Key field.

 6. Click Generate.

The text string "Copy the string below..." is returned in the text box below the instruction text.

 7. Copy this text into an email and send it to the email address provided on the Manual Registration
dialog box below the Activation Key field.

 8. Copy the license file that is returned in an email from Wordfast to the computer containing Wordfast
Pro.

 9. From within the Manual Registration dialog box, browse to the license file.

 10. Click OK.

 11. Restart Wordfast Pro.

The license is now active.

  Note:

To resolve any license issues, log in to Wordfast Pro and select Support > Hotline.

Managing Licenses

The following tasks help manage Wordfast Pro licenses:

• Re-installing Licenses • Viewing Current License • Viewing Updates

  Note:

Upon opening Wordfast Pro, an update notification appears when there are newer versions
available (see Help).

Re-installing Licenses

You can reinstall your Wordfast license by re-activating Wordfast Pro as described below:

 1. Obtain a new activation code for Wordfast Pro through the website http://www.wordfast.com/.

 2. Follow the instructions for:

•    Online Activation •    Offline Activation

http://www.wordfast.com/
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Viewing Current License

You can view the current license type and keep track of the days to expiry.

To view the current Wordfast Pro license:

 1. Open Wordfast Pro.

 2. Select Help.

 3. Click License Management.

The License Manager dialog box appears.

 4. Verify the license expiration date in the text below the Activation Key field.

The license status, as shown below, appears just below the Activation Key.

License will expire in 254 day(s)

Viewing Updates

Upon opening Wordfast Pro, an update notification appears when there are newer versions available.

Alternatively, check for updates as follows:

 1. Click Help.

 2. Click Wordfast 4 Update.
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A list of available updates appears (as shown).
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Starting Wordfast Pro 4
After Wordfast Pro has been installed and activated on your computer it is ready to use.

To start Wordfast Pro:

 • Open Wordfast Pro by double-clicking the Wordfast icon on the desktop, from the Start menu or the
installed folder.

The Projects tab appears. This view shows a list of all your projects and includes the Wordfast 4
drop-down menu.

Help

You can refer to the online help through the Help tab.
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On the Help tab you can:

• Provide comments

• View the latest Wordfast Pro updates

• Manage your Wordfast Pro license

• Display your version of Wordfast Pro

• Access online help

Project Files Perspective

When a project is opened from  the Project List tab, Wordfast Pro displays the Project Files tab where
the TXLF files for translation are listed.

TXLF Editor Perspective

When you open a file for translation or review, you are in the TXLF Editor. The TXLF Editor user
interface Translation tab is the main workspace for translation and review.
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Function Tabs This bar lists all tabs that fit in your display and are used to access
the various tools of this application.

Tools Ribbon Icons for the available tools of the active tab (that fit in your display).
File Name Tab(s) This bar lists all open files or chained file. Each open file shows as a

separate tab across this bar.
Table Filters Use this row of fields to provide the filter criteria and other controls

for your searches in the open file.
Source Segment The collection of numbered segments (color coded) that resulted

from sectioning the source file(s).
Editor Tabs In this work area a number of functions are available, including:

• TM Lookup

• Notes

• Segment History

• Metadata
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• Transcheck

Target Segment This is the translation work area that includes:

• Target column (right column) where the translation is entered
or leveraged

• Segment Score column contains the TM match percentage

• Status column indicates the status of that segment

Terminology Use this work area for searching and adding terms to terminology
lists (glossaries), if enabled.

Additional Tools This lists additional tools that do not fit in your display area.

Context Menu

The TXLF Editor Context Menu can be accessed by right-clicking anywhere in the Source or Target
segments.

Unlabeled Buttons

Translation files are TXLF files and you can edit these files using the TXLF Editor. The unlabeled
buttons used in theTXLF Editor are shown in the following table.

Button Description Icon Description

Transcheck error. A non-linguistic
error has occurred in the segment

A note has been added to the
segment
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Button Description Icon Description

The segment has been repeated
more than once in the file

The segment is locked and cannot be
edited

The segment is marked unconfirmed
and cannot be committed to the TM

Information is available

Apply the selected table filter Accumulate the selected table filters

Reset the Terminology search Filter
criteria

Clear the search filters

Select the term search target for
Terminology and Table Filters

Expand or collapse the options ribbon

Expand or collapse the lower panel Click to add a term to the glossary

The segment has been modified    
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Projects 5
The Projects tab is the starting point of using Wordfast Pro. Project creation is a one-time process that
allows you to add files, source and target languages, translation memories (TMs), glossaries, reference
files, and file format filters that can be used to prepare files for translation. When files for translation are
added to a project, they are automatically leveraged against the connected TMs and glossaries.

Project creation is not required if you are importing a GlobalLink Package (GLP) into Wordfast Pro. Refer
to Using GLP Files.

The tasks related to creating and managing projects are:

• Creating Projects • Opening Projects • Removing Projects

Searching and Sorting Projects

Projects can be searched and sorted using the column heads.

Option Description

Enter a search string to view specific projects and
projects in a particular location

To view projects in a specific language pair, select
a source and target language from the drop-down
lists

Click to clear the entered search filters

Click to sort the project details in ascending or
descending order
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Option Description

Click the sort menu to order the project details
based on a specific column head

Creating Projects

In Wordfast Pro, it is necessary to create a project before any file translation can take place. A TXLF file
can only be opened for translation after a project is created or opened. The project includes information
such as source language, target languages, TMs, glossaries, reference files, and file format filters that
can be used to prepare files for translation. There are two methods to create projects:

•    Simple Project Creation •    Advanced Project Creation

Simple Project Creation

To create a project using the simple method:

 1. Click the Create Project drop-down menu.

 2. Click Use the simple project creator.
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The Simple project creation dialog box appears.

 3. Enter a project name in the Project Name field.

 4. Select the source language from the Source language drop-down list.

 5. Select the target language from the Target language drop-down list.

 6. To add files:
• Click Add Files to browse to the files

• Or, drag the file(s) from a folder into the Files panel

The files appear in the Files panel.

  Note:

A green check-mark in the Valid column indicates the file is acceptable. A red X in the Valid column
indicates that the file type is not supported by Wordfast Pro filters.

 7. Select the Translation Memory for this project using one of the following options:

Radio Button Description

Add TM Connect to an existing local Translation Memory (TM)
database.
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Radio Button Description

Use Existing Connect to an existing Translation Memory from another
project.

Create New Build a new Translation Memory.

Do not use TM for this project No Translation Memory is to be used for this project.

 8. Click Finish.

Wordfast Pro analyzes the file(s) and displays a project summary.

 9. Click OK.

The project is created and ready to use. You can proceed to opening and translating the project files.
Refer to Translating Files.

Advanced Project Creation

In Advanced Project Creation you have the additional options to add remote translation memories,
glossaries, and reference files.
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To create a project using the advanced project creation wizard:

 1. Click the Create Project drop-down menu.

 2. Select Use the advanced project wizard.

The Project Creation Wizard appears.

 3. Enter a Project Name.

 4. Select an option for this project.

Option Description

Create a new project Create a project without reusing any previously created
project.

Create a project based on a
project not on the project list

Create a project reusing the profile of a previously created,
local project.
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Option Description

Create a project based on one
from the project list

Create a project with initial content from an existing project in
the project list.

Save Project To Browse to the location where the project will be saved.

 5. Click Next.

The Language Selection dialog box appears.

 6. Select the source and target languages:

a) To change the selected originating language, select a different language from the Source
Language drop-down list.

b) To change the selected translated language or add another language, select a different language
from the Target Language drop-down list.

c) Click Next.
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The Add Source Files dialog box appears.

 7. To add files:
• Click Add File to browse to the file.

• Or, drag the file(s) from a folder to the Files panel.

  Note:

To copy source files into the Source File folder within the Project folder on your computer, select the
Copy Source Files into Source Folder checkbox in Preferences > General dialog box.
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 8. Click Next.

The Translation Memory dialog box appears.

 9. Enter the required information.

a) Create a local TM.

• Enter a unique name for the new project.

• Select the languages.

• Browse and select the location where the TM file will be saved.

• Select TM Priority.

• Select whether TM will be Read-only.

b) Add Local TM.

• Select the TM folder.

c) Add Remote TM.

• Enter the TM Server or WF Server details

• Refer to Connecting to Remote TMs.

 10. Click Next.
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The Terminology dialog box appears.

 11. Enter the required information.

a) Create: create a new local glossary.

b) Add Local: browse and select an existing local glossary.

c) Add Remote: select an existing Term Manager connection.

 12. Click Next.

The References dialog box appears.

 13. To add files:
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• Click Add File to browse to the reference file.

• Click Add Folder to select a folder and add all reference files within.

 14. Click Finish.

The document files are analyzed. The Project Creation Summary appears upon completion.

Opening Projects

Projects must be opened before any files can be opened for translation.

To open a project from the Wordfast Pro Projects tab:

 1. Select a project.

 2. Click Open Project or double-click the project.
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The Project Files tab appears.

The Wordfast Pro Current Project tabs are described in the following sections:

• Project Files

• Project Terminology

• Reference Files

• Project TM

• Reports

• Help

Using GLP Files

A GlobalLink Package (GLP) file is downloaded from Project Director and contains all the required
information to carry out a translation project. Using this option, projects can be transferred between
different Wordfast Pro users. A GLP can contain both complete and incomplete projects. A GLP file can
include:

• All target translatable files and reference files

• Translation Memory connection

• Glossary connection

• Instructions

• Background Information

• Reference Files

• Source Files

To use a GLP file, you need to import the package into Wordfast Pro. Once imported, Wordfast Pro
connects to the TMs and glossaries, and provides you access to all the translatable files and additional
resources. The steps to import and export are described in the following sections:

• Importing Packages • Exporting Packages
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Removing Projects

To remove a project from the projects list:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select the project to remove.

 3. Click Remove Project.

The Remove dialog box appears.
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 4. Select one of the following:
• Remove from the list only: removes the project from the Projects list but retains the project

resources in the Project folder on your computer

• Remove from the list and move the following resources to Archive folder: removes the
project from the Projects list and moves the resources listed in the table to the Archive folder
within the Project folder on your computer

 5. Click OK.

The selected project is no longer in the Projects list.

  Note:

After a project is removed it can be added again. Removed projects are not erased and can be
retrieved from the Project folder on your computer using Add Project option.



Copyright © Wordfast, LLC 2016.   Page 35 of 211

Project Files 6
When Wordfast Pro is started, the Projects tab lists all projects that can be selected and opened. Once
a project is opened, all details of the project appear in separate tabs. The Project Files tab lists the
translatable files.

You can complete the following actions in the Project Files tab:

• Adding Files

• Modifying Projects

• Cleaning Up Projects

• Running Bilingual Export

• Running Export Notes Report

• Exporting Packages

• Adding Folders

• Closing Projects

• Analyzing Projects

• Running Segment Changes Report

• Importing Packages

• Removing Files

Searching and Sorting Project Files

Project files can be searched and sorted using the column heads.

Option Description

Enter a search string to view specific project files
and project files in a particular location

Click to clear the entered search filters

Click to sort the project files in ascending or
descending order
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Option Description

Click the sort menu to order the project file details
based on a specific column head

Adding Files

You can add files to an existing project using the Add Files option on the Project Files tab.

To add files to a project:

 1. Go to the Projects list tab (refer to Opening Projects).

 2. Open the project.

 3. Click Add Files.

 4. In the file Open navigation dialog box, browse to the file and select it.

 5. Click Open.



Chapter 6 - Project Files Wordfast

Copyright © Wordfast, LLC 2016.   Page 37 of 211

The file is analyzed and a Files Report appears.

Adding Folders

You can add a folder to an existing project using the Add Folders option on the Project Files tab.

To add files for translation from a folder to a project:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Open the project.

 3. Click Add Folders.

 4. Select a folder to add all files within.

 5. Click Select Folder.
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The files are added and a Files Report appears.

Modifying Projects

You can change a project's name, source language, and target language using the Modify Project
option.

To modify a project:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Open the project.

 3. Click Modify Project. 
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The Modify Project dialog box appears.

 4. Change the Project Name if required.

 5. Add or remove the Target Language(s).

 6. Click OK.

Closing Projects

When you complete working on a project, you can close it using the Close Project option. You can only
open one project at a time.

To close a project:

 • On the Project Files tab, click Close Project.

The project is closed and the Projects tab appears.
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Cleaning Up Projects

After files are translated, the translation project is ready for a clean up and an update to the Translation
Memory (TM). After clean-up, an automated process removes the source segments and restores the files
to their original format.

To clean up and update the Translation Memory:

 1. Go to the Projects tab. (refer to Opening Projects)

 2. Open the project.

 3. Click Project Clean Up.

The Project Clean Up dialog box appears.

 4. Select the languages to clean up by selecting one of the following:
• All Language Pairs

• Specific Language Pairs

• Single Language Pair
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 5. Select where the translated files are placed:
• Place translated files in the project folder

• Place translated files in the original path of source files

• Enter the location to put translated files

 6. Select Create subfolders by language.

 7. Select Add language suffix to the translated file name.

 8. Select TM Overwrite Options.

 9. Select the TM(s) to Update.

 10. Click Clean Up.

Analyzing Projects

In Analyzing Projects, files for translation are analyzed against a Translation Memory to leverage
reusable content and pre-translate files.

To analyze files:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select the project and click Open Project.

The Project Files tab appears listing the files for translation.

 3. Click Analyze Project.
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The Project Analyze dialog box appears.

 4. Select the file(s) to be analyzed.

 5. Select the Analysis Options as follows (refer to Configuring Translation Memory):

a) Select Pretranslate to create translated TXLF files, including the options:

• % matches: select the percentage of matches to pre-translate

• Copy all tags on segments when there is no TM match

• Copy segment source to target when there is no TM match

• Do nothing

  Note:

Selecting Pretranslate is an optional step. The percentage defines the minimum leverage required
to pretranslate a specific segment.

b) Select the format for the output report under Report Settings:

• Show only analysis report summary

• Export Report: Enter the Report Name,
Report Type, Report Location

c) Translation Memory: select one or more TMs to use during this analysis.
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 6. Click Analyze.

The analysis completes and the Report File appears.

Running Bilingual Export

The Bilingual export option allows you to export the TXLF file with highlighted glossary terms into a DOC
format and edit using Microsoft Word. Bilingual export can also be own outside the Projects dashboard
by using the Quick Tools. Refer to Bilingual Export.

To complete bilingual export of TXLF files from a project:

 1. Go to the Projects list tab (refer to Opening Projects).

 2. Select a file from the current project. To select multiple files, press the Ctrl key and select the files.

  Note:

Files that are open in the TXLF Editor cannot be selected for Bilingual Export. The glossaries and
TMs associated with the project will be leveraged. The Bilingual Export Options must be selected
in Preferences > General Preferences > General.

 3. Click Bilingual Export.
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 4. Select the folder to save the bilingual exported Word documents.

The log appears. This log and the exported documents are saved in the selected folder.

A sample of the bilingual export is given below.
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Running Segment Changes Report

The segment changes report can be run on all project files or a specific project file to view the history of
changes to a segment. The report includes the segment ID, TM score, source and target content with the
highlighted changes, username, timestamp, translator notes, and reviewer comments.

To run a segment changes report:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click Segment Changes Report.

The Segment Changes Report dialog box appears.

 4. Select the project files.

 5. Select Add Notes column for export, if required.

 6. Browse and select the Report Location.

 7. Click Export.
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The Segment Changes Summary and Segment Changes Report appears.

Running Export Notes Report

You can determine how many notes are attached to a project's files and view them in a report by running
an Export Notes Report.

To export notes:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click Export Notes Report.
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The Export Notes Report dialog box appears.

 4. Browse and select the Report Location.

 5. Click Export.

The Export Notes Summary appears.

 6. Click OK.

The Notes export file is created in the folder you selected.
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Importing Packages

Using the Import Package option, a GlobalLink Package (GLP) file can be imported into Wordfast Pro.
These GLP files are either exported from another Wordfast Pro installation or Project Director. When a
GLP file is imported, Wordfast Pro connects to the TMs and glossaries, and provides you access to all
the translatable files and additional resources. Refer to Using GLP Files for more information on GLP file
contents.

To import a package:

 1. Click Import Package or drag and drop a GLP file into the white space in the Projects tab.

The Import Package dialog box appears.

 2. Click Browse to locate and select the GLP file.
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 3. Click one of the following options:
• Update A Current Project: select an existing project to update with the imported GLP file. Select

one of the update current project options:

◦ Only update existing project TXLF files

◦ Update existing and add new files

• Create New Project: select to create a new project. Enter the new project details:

◦ Project Name: enter the new project name

◦ Location: click browse and select the location to save the new project

 4. (Optional) Select Open Project After Import to open the updated or new project when the import
completes.

 5. Click Import.

If Open Project After Import is selected, the current project view opens listing the files for
translation.

Exporting Packages

A GlobalLink Package (GLP) of project files comprises everything required for a project. Using the
Export Package option, a complete project package can be shared with other Wordfast Pro users. A
GLP file can be directly imported and opened in Wordfast Pro without requiring a manual project setup.
If the GLP file originated from Project Director, then once the translation work is completed in Wordfast
Pro, the GLP file can be exported and uploaded into Project Director. Refer to Using GLP Files for more
information on GLP file contents.
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To export a package:

 1. On the Project Files tab, select the project.

 2. Click Export Package.

The Export Package dialog box appears.
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 3. Select the export type:
• Entire Project: select to export the complete project

• Specific target languages and resources: select the Target Language(s) and resources to be
included in the export.

◦ Source Files

◦ TXLF Files

◦ Glossaries

◦ Translation Memories

◦ Reference Files

◦ Blacklists

 4. Select a naming convention.

• GLP Name to select a
default name

• Custom Name to
enter a name of your
choice

 5. Select a location where the GLP file will be saved.

 6. Click Export.

The exported GLP is built and saved to the selected folder location. This GLP file can be shared with
other Wordfast Pro users.

Removing Files

Files can be removed from a project through the Project Files tab.

To remove a file or files:

 1. Go to the Projects tab (refer to Opening Projects for more information).

 2. Select and open the project.

 3. Select the file to be removed.
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 4. Click Remove File(s).

The Remove dialog box appears.

 5. Select one of the following:
• Remove from the list only: removes the file from the Files list but retains the file in the Project

folder on your computer

• Remove from the list and move the following resources to Archive folder: removes the
file from the Files list and moves the resources listed in the table to the Archive folder within the
Project folder on your computer

 6. Click OK.

The file is removed from the current project.

  Note:

After a file is removed it can be added again. Removed files are not erased and can be retrieved
from the Project folder on your computer using Add Files option.
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Project TM 7
Translation memory (TM) is designed to provide maximum content re-use to and facilitate collaboration
between globally distributed localization resources. Translators can leverage reusable content in two
ways:

• Local TM: The local TM is located in your system and can only be accessed and updated by you.

• Remote TM: The remote TM is located on a server that can be accessed by several translators
at the same time. The translators can leverage the available content and also update the TM with
new reusable content.

TMs can be managed both by project managers and translators from the Project TM tab.

You can use the Project TM tab to complete the following tasks:

• Creating Local TMs

• Connecting to Remote TMs

• Modifying TMs

• Importing Local TMs

• Removing TMs

• Adding Local TMs

• Opening Local TMs

• Copying Local TMs

• Exporting Local TMs

Searching and Sorting Project TMs

Project TMs can be searched and sorted using the column heads.

Option Description

Enter a search string to view specific project TMs
and project TMs in a particular location
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Option Description

Click to clear the entered search filters

Click to sort the project TMs in ascending or
descending order

Click the sort menu to order the project TM details
based on a specific column head

Creating Local TMs

To create a local translation memory:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. On the Project TM tab, click Create Local.
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The Translation Memory dialog box appears.

 4. Enter the Translation Memory information.

Option Description

Name
Enter the TM name. It is recommended to enter a name that includes a client
or organization name and the TM's language to easily identify it.

Target Language The target language selection is limited to those configured in the project.

Location The location where the new TM will be saved.

Priority
The priority determines the sequence of reference during translation where
the Primary TM is referenced first, followed by the Secondary TMs. Only
one TM can be selected as primary.

Selected Select checkbox to use this local TM for the current project.

Read Only
Select checkbox to allow users to leverage the TM but not update it with new
translation.

 5. Click OK.

The new translation memory appears in the project TM list.
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Adding Local TMs

To add a local translation memory to a project:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project TM tab.

 4. Click Add Local.

 5. Select the translation memory folder.

 6. Click Select Folder.

The selected translation memory is added to the project and listed in the Project TM tab.

Connecting to Remote TMs

To connect to a remote TM:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project TM tab.

 4. Click Connect To Remote.
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The Connect to Remote TM dialog box appears).
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 5. To add a TM Server:

a) Click the TM Server tab.

b) Enter a unique name in the Symbolic Name field.

c) Enter the remote translation memory URL following the example template shown: example:// tm://
address:port/TMS?

  Note:

The URL Settings are populated automatically when you enter the URL string.

d) Select a Priority from the drop-down list.

The priority determines the sequence of reference during translation where the Primary TM is
referenced first, followed by the Secondary TMs. Only one TM can be selected as primary.

e) (Optional) Select Selected checkbox to use this translation memory for the current project.

f) (Optional) Select Read Only checkbox to allow users to leverage the TM but not update the TM
with new translation.

 6. To add a WF Server:
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a) Click the WF Server tab.

b) Enter a unique name in the Symbolic Name field.

c) Enter the remote translation memory URL following the example template shown: example:// wf://
jsmith:password@12345

  Note:

The URL Settings are populated automatically when you enter the URL string.

d) (Optional) Select Use TM Write Password to provide password to clean up target content and
update the TM.

e) Select a Priority from the drop-down list.

The priority determines the sequence of reference during translation where the Primary TM is
referenced first, followed by the Secondary TMs. Only one TM can be selected as primary.

f) (Optional) Select Selected checkbox to use this translation memory for the current project.

g) (Optional) Select Read Only checkbox to allow users to leverage the TM but not update the TM
with new translation.
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 7. Click OK.

The new translation memory is created in the project TM list.

Opening Local TMs

Local translation memories can be viewed and edited in Wordfast Pro.

To open a local translation memory:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Select a translation memory file.

 4. Click Open TM.
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The TM Editor tab appears.

 5. You can filter, view, and update translation units using the TM Editor.

Modifying TMs

To modify a local or remote translation memory:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project TM tab.
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 4. Click Modify TM.

The Modify TM dialog box appears.    

 5. Modify the TM details as required.

 6. (Optional) Select Selected checkbox to use this TM for the current project.

 7. (Optional) Select Read Only checkbox to allow users to leverage the TM but not update it with new
translation.

 8. Click OK to save changes.
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Copying Local TMs

To copy a local translation memory:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project TM tab.

 4. Select a translation memory.

 5. Click Copy TM.

The Copy Translation Memory dialog box appears.

 6. Enter the TM Name for the copy and its destination folder.

 7. Enter the Location where the TM will be saved.

 8. Select Flip Languages, to reverse the source and target languages.

 9. Click Copy.



Chapter 7 - Project TM Wordfast

Copyright © Wordfast, LLC 2016.   Page 64 of 211

A copy of the translation memory is saved in the selected folder location.

Importing Local TMs

To import a translation memory:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project TM tab.

 4. Click Import TM.

The Import Translation Memory dialog box appears.
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 5. Select the import File Type:
• WF Classic TM: This file format can be used in Wordfast Classic and Wordfast Pro 3 translation

tools.

• TMX: This is a standard file format supported by all translation tools.

 6. Click Browse to locate and select the Import File.

 7. Select the TM creation option:
• Create New TM: to import the TM into a new TM file

• Import Into Existing TM: to import the TM into one of the available TM files. Select the Existing
TM and the action to be taken If TU already exists

 8. Click OK.

The translation memory is imported and appears in the project TM list.

Exporting Local TMs

To export a local translation memory:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project TM tab.

 4. Select the translation memory file to export.

 5. Click Export TM.
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The Export Translation Memory dialog box appears.

 6. Select a different Translation Memory from the drop-down list, if required.

 7. Select the file Export Type from the drop-down list.

 8. Click Browse and select the folder location where the exported file should be saved.

 9. Click OK.

The selected translation memory is exported to the selected folder location.

Removing TMs

When a translation memory is removed from a project, the local TM file is retained in the TM folder on
your computer and can be added again by clicking on Add Local. The remote TM can be added again
by clicking on Connect to Remote and entering the URL.

To remove a translation memory from the current project:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Click the Project TM tab.
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 3. Select the TM to be removed.

 4. Click Remove TM.

A Remove TM dialog box appears.

 5. Click Yes.

The selected translation memory is removed from the TM list.
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Project Terminology 8
Project Terminology tab is used to manage the glossaries and blacklisted terms. A glossary is a
collection of terms used in previous translation projects. These terms could be both preferred and
rejected or blacklisted.

You can use the Project Terminology tab to complete the following tasks:

• Working with
Glossaries

• Working With Blacklists • Modifying and Removing
Glossaries, Blacklists

Searching and Sorting Project Terminology

Project Terminology or Glossary can be searched and sorted using the column heads.

Option Description

Enter a search string to view specific project
glossaries and project glossaries in a particular
location

Click to clear the entered search filters

Click to sort the project glossaries in ascending or
descending order
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Option Description

Click the sort menu to order the project glossary
details based on a specific column head

Working with Glossaries

A terminology list or glossary includes source terms and their preferred translations.

You can use the Terminology panel of the Project Terminology tab to complete the following tasks:

• Creating Local Glossaries

• Opening Local Glossaries
• Adding Local Glossaries

• Importing Local Glossaries
• Connecting to Remote

Glossaries

• Exporting Local Glossaries

Creating Local Glossaries

To create a local glossary:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project Terminology tab.

 4. Click Create Local.
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The Create Glossary dialog box appears.

 5. Enter a unique Name for the glossary.

 6. Select the Target Language.

 7. Browse to a folder Location where the new glossary should be saved.

 8. (Optional) Select Selected checkbox to use this local glossary for the current project.

 9. (Optional) Select Read Only checkbox to leverage the local glossary but not update it with new
terms.

 10. Click OK.

The new glossary appears in the project terminology list.

Adding Local Glossaries

To add a local glossary:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project Terminology tab.

 4. Click Add Local.
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 5. Browse and select the glossary folder.

 6. Click Select Folder.

The selected glossary is added to the project and listed in the Project Terminology tab.

Connecting to Remote Glossaries

To connect to a remote glossary:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project Terminology tab.

 4. Click Connect To Remote.
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The Connect to Term Manager dialog box appears.

 5. Click the TMGR Server or WF Server tab.

 6. Enter a unique name in the Name field.

 7. Select a Target Language from the drop-down list.

 8. Enter the remote glossary URL following the example template shown: example:// tmgr://
address:port/tmgr?

  Note:

The URL Settings are populated automatically when you enter the URL string.

 9. (Optional) Select Selected checkbox to use this glossary for the current project.

 10. (Optional) Select Read Only checkbox to allow users to leverage the glossary but not update it with
new terms.

 11. (Optional) Select Create Blacklist Connection to include a term blacklist.

 12. Click OK.

The new glossary is created in the project terminology list.
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Opening Local Glossaries

To open a local glossary:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project Terminology tab.

 4. Select a glossary and click Open Glossary.

The Glossary Editor tab appears.

 5. You can filter, view, add, remove, and update terms using the Glossary Editor.

Importing Local Glossaries

To import a glossary:

 1. Go to the Projects tab (refer to Opening Projects).
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 2. Select and open the project.

 3. Click the Project Terminology tab.

 4. Click Import Glossary.

The Import Glossary dialog box appears.
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 5. Select the import File Type:
• Tab delimited text file (TXT): Wordfast Classic and Wordfast Pro 3 format

• Term Base eXchange (TBX)

 6. Click Browse to locate and select the Import File.

 7. Select the glossary creation option:
• Create a new glossary: to import the glossary into a new glossary file

• Import into existing glossary: to import the glossary into one of the available glossary files.
Select the Existing Glossary and the action to be taken If the term already exists

 8. Select Clear before import to overwrite the existing glossary.

 9. Click OK.

The glossary is imported and appears in the project terminology list.

Exporting Local Glossaries

To export a local glossary:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project Terminology tab.
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 4. Select the glossary to export.

 5. Click Export Glossary.

The Export Glossary dialog box appears.

 6. Select a different Glossary from the drop-down list, if required.
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 7. Select the file Export Type from the drop-down list:
• Tab delimited text file (TXT): Wordfast Classic and Wordfast Pro 3 format

• Term Base eXchange (TBX)

 8. Click Browse and select the folder location where the exported file should be saved.

 9. Click OK.

The glossary is exported to the selected folder location.

Working With Blacklists

A blacklist includes words or phrases that should not be used in the target segment.

You can use the Blacklist panel of the Project Terminology tab to complete the following tasks:

• Creating Local Blacklists

• Importing Local Blacklists
• Adding Blacklists

• Exporting Local Blacklists
• Opening Local Blacklists

Creating Local Blacklists

To create a local blacklist:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project Terminology tab.
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 4. Click Create Local in the Blacklist panel.

The Create Blacklist dialog box appears.

 5. Enter a unique name for this blacklist.

 6. Select a Language.

 7. Browse to a folder Location where the new blacklist should be saved.

 8. (Optional) Select Selected checkbox to use this local blacklist for the current project.

 9. (Optional) Select Read Only checkbox to leverage the blacklist but not update it with new terms.

 10. Click OK.

The new blacklist appears in the project terminology list.
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Adding Blacklists

To add a blacklist:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project Terminology tab.

 4. Click Add Local in the Blacklist panel.

 5. Browse and select the blacklist folder.

 6. Click Select Folder.

The selected blacklist is added to the project and listed in the Project Terminology tab.

Opening Local Blacklists

To open a local blacklist:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project Terminology tab.
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 4. Select a blacklist and click Open Blacklist.

The Blacklist Editor tab appears.

 5. You can filter, view, add, remove, and update terms using the Blacklist Editor.

Importing Local Blacklists

To import a local blacklist:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project Terminology tab.
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 4. Click Import Blacklist.

The Import Blacklist dialog box appears.

 5. Select the import File Type.

 6. Click Browse to locate and select the Import File.

 7. Select the blacklist creation option:
• Create a new blacklist: to import the blacklist into a new blacklist file

• Import into existing blacklist: to import the blacklist into one of the available blacklist files. Select
the Existing Blacklist and the action to be taken If the term already exists

 8. Select Clear before import to overwrite the existing blacklist.

 9. Click OK.

The blacklist is imported and appears in the project terminology list.
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Exporting Local Blacklists

To export a blacklist:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project Terminology tab.

 4. Click Export Blacklist.

The Export Blacklist dialog box appears.

 5. Select a different Blacklist from the drop-down list, if required.

 6. Select the file Export Type.

 7. Click Browse and select the folder location where the exported file should be saved.

 8. Click OK.

The blacklist is exported to the selected folder location.
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Modifying and Removing Glossaries, Blacklists

You can use the Options panel of the Project Terminology tab to complete the following tasks:

• Modifying Glossaries

• Modifying Blacklists
• Removing Glossaries

• Removing Blacklists

Modifying Glossaries

To modify a glossary:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project Terminology tab.

 4. Select the glossary and click Modify.



Chapter 8 - Project Terminology Wordfast

Copyright © Wordfast, LLC 2016.   Page 84 of 211

The Create/Modify Glossary or Connect to Remote Glossary dialog box appears based on the
glossary type.

 

 5. Modify the glossary details as required.

 6. (Optional) Select Selected checkbox to use this glossary for the current project.

 7. (Optional) Select Read Only checkbox to allow users to leverage the glossary but not update it with
new terms.

 8. Click OK to save all changes.
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Removing Glossaries

When a glossary is removed from a project, the local glossary file is retained in the glossary folder on
your computer and can be added again by clicking on Add Local. The remote glossary can be added
again by clicking on Connect To Remote and entering the URL.

To remove a local glossary:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Project Terminology tab.

 4. Select the glossary to be removed.

 5. Click Remove.

The Remove Glossary(ies) dialog box appears.

 6. Click Yes.

The selected glossary is removed from the terminology list.

Modifying Blacklists

To modify a blacklist:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.
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 3. Click the Project Terminology tab.

 4. Select the blacklist and click Modify.

The Modify a Blacklist or Connect to Remote Blacklist dialog box appears based on the blacklist type.

 5. Modify the blacklist details as required.

 6. (Optional) Select Selected checkbox to use this blacklist for the current project.

 7. (Optional) Select Read Only checkbox to allow users to leverage the blacklist but not update it with
new terms.

 8. Click OK to save changes.

Removing Blacklists

When a blacklist is removed from a project, the local blacklist file is retained in the blacklist folder on your
computer and can be added again by clicking on Add Local. The remote blacklist can be added again by
clicking on Connect To Remote and entering the URL.
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To remove a blacklist from the current project:

 1. Go to the Projects tab (refer to Opening Projects)

 2. Select and open the project.

 3. Click the Project Terminology tab.

 4. Select a blacklist to remove.

 5. Click Remove.

The Remove Blacklist dialog box appears.

 6. Click Yes.

The selected blacklist is removed from the terminology list.



Copyright © Wordfast, LLC 2016.   Page 88 of 211

Reports 9
The Reports tab displays all analysis and cleanup reports that can be exported for reference into CSV,
HTML, XLS, and PDF formats.

You can use the Reports tab to complete the following tasks:

• Opening Reports • Exporting Reports • Removing Reports

Searching and Sorting Reports

Reports can be searched and sorted using the column heads.

Option Description

Enter a search string to view specific reports and
reports in a particular location

Click to clear the entered search filters

Click to sort the reports in ascending or
descending order

Click the sort menu to order the report details
based on a specific column head
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Opening Reports

To open a report:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Reports tab.

 4. Select a report and double-click it.
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The Report File appears.

Exporting Reports

To export a report:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Select the Reports tab.
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 4. Click Export and select a format from the drop-down menu.

The export formats available are:

• CSV

• HTML

• XLS

• PDF

 5. Enter a file name and select the folder location to save the report.

 6. Click Save.

The report is saved in the selected folder location.

Removing Reports

To remove a report:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Select the Reports tab.

 4. Select a report to be removed.

 5. Click Remove Report.
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The report is removed from the reports list.

  Note:

After a report is removed it can be viewed again. Removed reports are not erased and can be
retrieved from the Project folder on your computer.
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Reference Files 10
Reference files can be included with a project to provide context to the translation project. These could
include definitions, illustrations, workflow diagrams, notes, etc,.

You can use the Reference Files tab to complete the following tasks:

• Adding Reference Files

• Opening Reference Files
• Showing Instructions

• Removing Reference Files

Searching and Sorting Reference Files

Reference files can be searched and sorted using the column heads.

Option Description

Enter a search string to view specific reference
files and reference files in a particular location

Click to clear the entered search filters

Click to sort the reference files in ascending or
descending order

Click the sort menu to order the reference file
details based on a specific column head
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Adding Reference Files

To add reference files:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Reference Files tab.

 4. Click Add Files.

 5. Browse and select the reference file. To select multiple reference files, press Ctrl and select them.

 6. Click Open.

The file(s) is added to the reference files list.

Opening Reference Files

To open a reference file:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select a project.

 3. Click Open Project.

 4. Click the Reference Files tab.
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 5. Select a reference file and click Open File.

The selected file opens.

Showing Instructions

When a translation submission is created in Project Director (PD), specific instructions can be added to
the submission for the translator and reviewer. These instructions are then downloaded from PD as part
of the GlobalLink Package (GLP) file. When this GLP file is imported into Wordfast Pro, the instructions
are available for viewing through the Reference Files tab.

To view instructions:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Reference Files tab.

 4. Click Show Instructions.
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The Instructions dialog box appears.

Removing Reference Files

To remove reference files:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Reference Files tab.

 4. Select the reference file(s) to be removed.

 5. Click Remove File(s).
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The Remove dialog box appears.

 6. Select one of the following:
• Remove from the list only: removes the reference file from the files list but retains the reference

files resources in the Project folder on your computer

• Remove from the list and move the following resources to Archive folder: removes the
reference file from the files list and moves the resources listed in the table to the Archive folder
within the Project folder on your computer

 7. Click OK.

The selected file is removed from the reference file list.

  Note:

After a reference file is removed it can be added again. Removed reference files are not deleted
and can be retrieved from the Project folder on your computer using Add Files option.
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Translating Files 11
After completing the initial steps of creating a project, connecting to translation memories, and
glossaries, the project files are ready for translation.

The translation process includes the following tasks:

• Opening and Translating Files

• Translating All Segments

• Using Terminology Lists

• Finding and Replacing Content

• Using Notes

• Using Transcheck

• Using Auto-Suggest

• Saving Files

• Chaining Files

• Using TMs

• Working with Tags

• Using Table Filter

• Working with Segments

• Enabling Machine Translation

• Leveraging Repetitive Content

Opening and Translating Files

After a project is opened, the files that comprise the project are accessible from the Project Files tab.
When the project has numerous files, the files can be chained together into one contiguous file. Refer to
Chaining Files.

To open a file for translation:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.
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 3. Select the file to translate.

 4. Click Translate File.

The source and the leveraged target content appear in the Translation tab.

 5. Select a Target segment and enter the translation.

  Note:

All tags in the Source segment should be either copied or entered manually into the Target
segment.

 6. Click Next Segment or press Alt+Down to update the TM and move down one Target segment.

 7. Save your work often by pressing Ctrl+S or clicking Save on the File tab. Refer to Saving Files.
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Chaining Files

Multiple files can be combined and viewed as one file using Chain Files. For example, if you are
translating ten files with ten segments each, these files can be chained into one file of 100 segments.

To chain files into one file:

 1. On the Project Files tab, select the files to be chained.

 2. Click Chain Files.

The chained file opens in the Translation tab with a default name "Chained Files 1". In the ID
column, the segments from each file are sequentially numbered and highlighted in a unique
background color.

 3. Click in any segment.
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The file name changes from the default name to the name of the source file.

 4. Translate and review the segments until segment ID 1 appears again and the background color
changes indicating a different source file.

 5. Press Ctrl+S or click Save on the File tab to save the chained file.

When the chained file is saved, the segments are restored to their original files and the chained
format is not retained.

  Note:

Chained files can only be opened in the TXLF Editor. You can open and work on multiple sets of
chained files. Chained files cannot be exported and saved as a single file.

Translating All Segments

The Translate All option completes the translation of all segments by leveraging the connected TMs.

To translate a project file using Translate All:

 1. Click into any of the segments.
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 2. Click Translate All.

The connected TMs are leveraged and the segments are populated with translations. When the
translation is completed, the screen is refreshed with the results and the green bar at the bottom
indicates the percentage translated.

Using TMs

Translation memory (TM) is designed to provide maximum content re-use and facilitate collaboration
between globally distributed localization resources. The following is a list of those tasks and associated
procedures:

• TM Color Codes

• Using TM Lookup
• Leveraging TMs

• Viewing TM Leverage Results

TM Color Codes

When a project is connected to a translation memory (TM), all project files are leveraged against it. Each
segment is highlighted in different colors to represent the TM match.

Color Description

Yellow Fuzzy match

Grey No match

Green 100% match
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Color Description

Dark Green Context match. A segment is considered a context
match in the following scenarios:

• if the previous and next segments also have
a 100% match

• if the 100% matched segment is a single
paragraph

Pink Modified segment

Purple Modified segment updated or committed to the TM

Light Purple Auto-propagated. A segment is considered auto-
propagated when a segment is translated and
committed, and other repetitive segments are
automatically updated with the translation

Light Pink Machine Translated

Leveraging TMs

To leverage a translation memory:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Select the file to translate.

 4. Click Translate File on the Project Files tab.
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The file is leveraged against the translation memory and the results displayed in the Target Segment
column.

 5. Select the segment to leverage from the Source column.

 6. In the Segment or Automated Actions group on the Translation tab, click one of the following:
• Leverage to retrieve suggestions from the active TM for the selected source segment

• Until Fuzzy to retrieve suggestions from the active TM until the next Fuzzy match

• Until No Match to retrieve suggestions that from the active TM for the all source segments until
no exact match is found

• Translate All to automatically translate all segments.

The leveraged content appears in the Target column when a match is found. When Machine
Translation is enabled, the Machine Translation match is populated.

Using TM Lookup

The Translation Memory lookup is used to view TM leverage results and concordance search results.
This search looks for specific source segment text in the translation memory. The results show source
and target segments.

Translation Memory leverage search occurs automatically, as a user navigates through the segments, to
provide the users with the best possible full segment matches from the TM. It is also the only search that
uses scoring to decide which match is the best.
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To perform concordance search:

 1. Enter a word or phrase in the TM Lookup text box.

In this example, the string vendor searches segments ignoring case and includes matches containing
any of the specified words.

 2. Click Find Source or Find Target.

Without using a case sensitive search there are numerous results.

 3. To further refine the search, using the string VENDOR, select Case Sensitive under More Options.

Option Description

Case Sensitive Filter by case

Exact Filter for only those terms that appear in the same order

Automatic Leverage Filter for TUs that are matched in the TM
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Option Description

Diff Highlight Highlight the difference between source and TM source as well as
differences between target and TM target

Include Private TU (GLTMS) Include private Translation Units in the search for remote GLTMS
TMs

Rerunning the search with Case Sensitive selected returns fewer results.

Viewing TM Leverage Results

To view TM leverage results in TM Lookup:

 1. Click in any of the source or target segments.
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The TM Lookup tab is populated with TM leverage results.

 2. You can view the following TM leverage details:

Column Description

Source The source segment will be highlighted if it is a fuzzy match. The green highlight
indicates the content that was searched in the TM, and the red highlight
indicates the content that was returned from the TM

Target The target segment from the TM

Score The TM leverage score. The scores are denoted as follows:

• Percent (%): 100% and fuzzy matches

• Plus (+): Context matches

• Asterisk (*): Secondary TM match

• Red outline around score box: TU has penalties

Refer to TM Color Codes for more information on TM color codes

TM Name The name of the TM that was leveraged. If multiple TMs are leveraged, then the
primary TM leverage will appear first, followed up secondary TMs

Creation Date The date when the translation unit (TU) was created in the TM

Creation User The user who created the TU
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Column Description

Last Modified The date when the TU was last modified

Modification User The user who modified the TU

Custom Attribute Attribute name and values for a TU

Click to view the TM Lookup Info dialog box which displays the translation unit
and score breakdown information including penalties

Using Terminology Lists

Terminology lists or glossaries include source terms and their preferred translations. To set up a
terminology list refer to Project Terminology.

When a segment is selected, all terms within that segment that are in the terminology list or glossary
are highlighted and shown with their translation in the Terminology panel. You can navigate through all
terms by clicking the Next Term and Previous Term buttons on the Terminology tab or pressing Ctrl+8
and Ctrl+9.
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The Terminology panel can be used to manage terms:

• Terminology Color Codes

• Removing Terms

• Viewing and Copying
Synonyms

• Adding Terms

• Inserting Terms
• Editing Terms

• Copying Terms

Terminology Color Codes

When a project is connected to a terminology list or glossary, all terms that exist in an open file are
highlighted in different color codes. The terms are highlighted when the user selects a segment or by

clicking the  under the Terminology tab. These color codes represent the type of translation
match against the terminology list or glossary.

Source/Target Target Exact Match Target Fuzzy Match Target No Match

Source Exact Match Green/Green Green/Yellow Red/No color

Source Fuzzy Match Yellow/Green Yellow/Yellow Purple/No color
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Adding Terms

To add terms to a glossary from the Terminology panel:

 1. Do one of the following:
• Select a word in the source segment and the translation in the target segment, and click the Add

icon .
 

 

The Add Term dialog box appears.
 

 

• Select a term in the source segment, and click the Add icon , in the Terminology panel.

The Add Term dialog box appears where you can enter the translation for the term in the Target
field.
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 2. (Optional) Enter a term Description.

 3. Select the Glossary to save the term.

 4. Click OK.

Editing Terms

To edit terms in a glossary from the Terminology panel:

 1. Select the term to edit.

 
2. Click the Edit icon .

The Edit term dialog box appears.

 3. Edit the term as required.

 4. Click Modify.
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Removing Terms

To remove terms in a glossary from the Terminology panel:

 1. Select the term to remove.

 
2. Click the Remove icon .

A Warning message appears.

 3. Click Yes.

Inserting Terms

To insert a term into the current target from the Terminology panel:

 1. Click in the target segment where the term should be inserted.

 2. Select the term to insert from the Terminology panel.

 
3. Click the Insert icon .
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The selected term is inserted into the target segment at the selected location.

Copying Terms

To copy a term translation from the glossary into the current target:

 1. Go to the Terminology tab and click on a segment with glossary terms.

 2. Click Previous Term (Ctrl+8) or Next Term (Ctrl+9) to select a source term.
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 3. Click within the target segment where the term translation should be copied.

 4. Click Copy or press Ctrl+0.

The translation of the selected source term is copied into the target segment.

Viewing and Copying Synonyms

To view and copy synonyms for a term:

 1. Do one of the following:
• Click Previous Term (Ctrl+8) or Next Term (Ctrl+9) to select a source term.

• Click the source term to select it.
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The source term is highlighted with a broad border. The term synonyms appear as a pop-up and in
the Terminology panel.

 2. Click within the target segment where the term translation should be copied.

 3. Do one of the following:
• Click Copy or press Ctrl+0 and select the preferred term translation.

• Select the preferred term translation from the Terminology panel.

The selected translation of the source term is copied into the target segment.

Working with Tags

A tag is inline text that is wrapped in a special character pair and is not translatable. For example, HTML
code tags within a sentence. Target segments should have the same tags as the source segment.
However, depending on the language, sometimes a tag is not needed. If an attempt is made to save a
target segment with missing tags, a warning message appears.

This section includes the following tasks:

• Viewing Tags

• Clearing All Tags
• Copying Tags

• Editing Tags
• Copying All Tags

• Deleting Tags
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Viewing Tags

To view tags:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Select a file and click Translate File.

 4. Click the Translation tab.

The file appears under the Translation tab. If tags exist in the source segment, they appear in purple
if they are formatting tags and gray for non-formatting tags. The first tag in a selected segment
appears in red.

For example, the numeral one ( ) is highlighted in red to indicate it is a selected tag.
 5. Mouse over a tag to view the tool-tip information.

Copying Tags

Tags can be selected and copied individually or copied as a group.

To copy tags:

 1. Click Translate File on the Project Files tab.

The file appears under the Translation tab. If tags exist in the source segment, they appear in purple if
they are formatting tags and gray for non-formatting tags. The first tag in a selected segment appears
in red.

 2. Select the tag to be copied.
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 3. Drag the selected tag into the target segment or click Copy or press Ctrl-Alt-Down.

The tag is copied and the target segment is highlighted in pink.

Copying All Tags

To copy all tags:

 1. Click Translate File on the Project Files tab.

The file appears under the Translation tab. If tags exist in the source segment, they appear in purple if
they are formatting tags and gray for non-formatting tags. The first tag in a selected segment appears
in red.

 2. Click Copy All Tags in the Clipboard group of the Edit tab, to expand the drop-down menu.

The Copy All Tags menu appears.

 3. Select one of the following:
• Segment or press Alt-A to copy only the tags for the selected segment to the target

• Document or press Alt-Shift-P to copy all tags for the entire document

  Note:

Copied tags appear at the location of the cursor. They must be reordered to appear correctly. Drag
and drop the translated text between the tags, or cut and paste the translation between the tags.

 4. Enter the translation between the copied tags, if necessary.
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Clearing All Tags

Tags can be cleared only from a target, and from either the current segment or from the entire document.

To clear all tags:

 1. Go to the Projects list tab (refer to Opening Projects).

 2. Select and open the project.

 3. Select a file and click Translate File.

 4. Click the Edit tab.

 5. Place the cursor within the target segment.

 6. Click Clear All Tags.

 7. Select one of the following:
• Segment from the drop-down menu or press Ctrl-Shift-V to clear all tags from the segment

• Document from the drop-down menu to clear all tags from the document

A warning message appears.

 8. Click Yes to clear all tags.

Editing Tags

To edit tags:

 1. Go to the Projects list tab (refer to Opening Projects).

 2. Select and open the project.

 3. Select a file and click Translate File.

 4. Select a segment to edit.

If tags exist in the source segment they are shown.

 5. Highlight the tag to be edited in the target segment as shown in the following example.
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 6. To open the Edit Tag dialog box, right-click on the tag and select Edit Tag from the drop-down menu.

  Note:

Tags in the source segment should not be edited.

Ensure that all tag edits are valid, otherwise the TXLF file could become corrupt.

The Edit Tag dialog box appears.

 7. Edit the tag as required.

 8. Click OK.

Deleting Tags

Tags can be deleted only in the target segment.

To delete tags:

 1. Go to the Projects tab (refer to Opening Projects).
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 2. Select and open a project.

 3. Select a file and click Translate File.

 4. Click the Edit tab.

The file content appears. If tags exist in the source segment, they appear in purple if they are paired
tags and gray for non-paired tags. The first tag in a selected segment appears in red.

 5. In the target segment, select the tag for deletion.

 6. Delete the tag by doing one of the following:
• Press Delete

• Click Cut on the Edit tab

• Press Backspace

The Undo option is available on the Edit tab.

Finding and Replacing Content

Text in translated content can be searched for and replaced using the Find / Replace option.

To find and replace text in a file:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Click the Edit tab.
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 4. Click Find/Replace.

The Find/Replace dialog box appears.

 5. Under the Find tab, enter the search text in the Find What: field.

  Note:

Search text can include non-breaking spaces.

 6. Click Find Next repeatedly to move through all instances of the term.

 7. Select Reading Highlight to highlight all instances of the term in all open files.

 8. Select the Replace tab to replace terms.

 9. Enter the Replace with text.
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 10. Click one of the following:
• Replace, to replace the found content only

• Replace All, to replace all instances of that content

• Find Next, to move to the next instance of the content

More Options:

Option Description

Backward Search from cursor location to file beginning

Forward Search from cursor location to file end

Ignore Case Search for all instances of a word or phrase ignoring case

Whole Words Only Search for all instances of only whole word matches

Ignore Non-breaking Space
Search for all instances of a word or phrase including non-breaking
spaces

Search Source Search for all instances of a word or phrase in the source only

Search Target Search for all instances of a word or phrase in the target only

Search Through Open Files Search for all instances of a word or phrase in all open files

Using Table Filter

The Table Filter shows results based on the selected filter and entered search string.
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Item Description

The Source/Target filter menu options are:

• Source: searches the source language segments

• Target: searches the target language segments

• Source and Target: searches both source and target

• Source or Target: searches either source or target (default)

Enables search to be case-sensitive

Enables search of regular expression and wildcard characters

Enter the search string to filter segments
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Item Description

Drop-down list of all available search filter criteria:

• 100% match segments: segments matching completely in the
TM

• All except 100% and In Context match segments: segments
with partial TM match, no match, or modified segments

• All except auto-propagated: all statuses except the segments
that are auto-propagated

• Auto-propagated segments: all auto-propagated matches

• Committed segments: segments with translated content
committed to the TM

• Context match segments: all 100+% context matches. Context
matches provide more refined matches that are based on
contextual references in the TM. For example, a segment
is considered a context match when the previous and next
segments also have a 100% match against the TM

• Duplicate segments: segments being duplicated in the file

• Edited source segments: source segments that have changed

• Empty target segments: segments without a translated target

• Fuzzy match segments: segments with partial TM match

• Machine translated segments: segments translated by a
machine. This option requires Machine Translation to be enabled
in the project

• Modified segments: all modified segments. By default all
modified segments are highlighted in pink

• No match segments: segments with no match in the TM

• Segments with Transcheck warnings: segments with
Transcheck warning status

• Segments with history: segments that have been edited and has
a segment revision history viewable in the Segment History tab

• Segments with notes: segments containing comments

• Segments with repetitions: segments with repeated text strings

• Short segments: segments of fewer than {#} words, paragraphs
or other blocks

• Unconfirmed segments: segments marked unconfirmed

Apply the selected filter
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Item Description

Add a selection of filters to apply in order of selection

Clear all fields in Table Filter tool bar

Sort the filtered results by selected criteria where Document is selected
by Default

Configure additional table filter options by entering maximum segment
filter word count. This option is applied to the Short segments filter

Using Notes

While translating or reviewing translated content, notes specific to each segment can be added.

A project's notes are accessible through the Review tab.
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You can use the Review tab to complete the following Notes specific tasks:

• Viewing Notes

• Deleting Notes
• Adding Notes

• Exporting Notes
• Editing Notes

Viewing Notes

To view notes:

 1. Select the file where notes are to be viewed.

 2. Double-click a file or click Translate File.

The file appears under the Translation tab.

The segments with notes will include a Note icon in the Status column.
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 3. Click the Notes tab in the Editor Tabs work area.

The available notes are listed.

Adding Notes

To add a note:

 1. Place the cursor in the segment where the note is to be added.

 2. Use one of the following methods to open the Notes dialog box:
• Click Add in the Notes group of the Review tab.

• Click Add under the Notes tab of the Editor.

• Right-click the segment and click Add.
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The Add/Edit Notes dialog box appears.

 3. Select the note Type.

 4. Enter the note text.

 5. Click OK.

The note appears under the Notes tab and the Notes icon appears in the Status column.

Editing Notes

To edit a note:

 1. Place the cursor in the segment where the note is to be edited.

 2. Select the note to be edited under the Notes tab.

 3. Use one of the following methods to edit the note:
• Click Edit in the Notes group of the Review tab.

• Click Edit under Notes tab.

• Right-click the segment and click Add.
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The Add/Edit Notes dialog box appears.

 4. Edit the note.

 5. Click OK.

The modified note appears under the Notes tab.

Deleting Notes

To delete notes:

 1. Select the segment where the note is to be deleted.

 2. Select the note to be deleted under the Notes tab.

 3. Use one of the following methods to delete the note:
• Click Delete in the Notes group of the Review tab.

• Click Delete under the Notes tab.

• Right-click the segment and click Delete.
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Exporting Notes

To export notes:

 1. Use one of the following methods to export notes:
• Click Export in the Notes group of the Review tab.

• Click Export under the Notes tab.

• Right-click the segment and click Export.

The Export Notes dialog box appears.

 2. Browse and select a location to save the exported file.

 3. Enter a name for the file and click Save.

The file is saved in the selected folder location as a Word document.

Working with Segments

Segments are parts of the file that are divided by formatting or punctuation. Typically, segments are
sentences, but may be words or numbers, depending on the formatting of the source file. When a file
is converted to a translatable TXLF format, all complete sentences become separate segments. Once
these segments are translated, they are saved and committed to the translation memory and leveraged
in future translations. Translation memory leveraging reduces the time and expense of future translations
by automatically and consistently translating reoccurring words and phrases.

Refer to the following tasks:

• Viewing Segment History

• Committing to the TM

• Unconfirming and Confirming
Segments

• Copying All Sources

• Locking Segments

• Clearing Targets

• Copying Source

• Clearing All
Targets

• Editing Source
Segments

Viewing Segment History

The Segment History tab is used to view the segment changes in the currently open file.
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Committing to the TM

After translating all the source segments, the translation memory should be updated. The Commit All
option updates all target segments and the Commit option updates the current target segment to the
TM.

To update the translation memory:

• Click Commit All in the Translation Memory group or Commit in the Segment group.

The translation memory is updated for the entire file or the current segment. When a modified
segment is committed to the TM, the highlight color changes to purple.

Copying Source

To copy a source segment to the target segment:

 1. Select a source segment.
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 2. Click one of the Copy Source options.

To copy source as it appears in the source segment you can also press Alt-S.

The source segment is copied to the target segment.

Copying All Sources

All source content can be copied into all the target segments using Copy All Sources.

To copy all source segments to all target segments:

• Click Copy All Sources in the Segment group.

All source content is copied into the target segments.

Locking Segments

The confirmed, proofread, and translated segments can be locked to ensure that they are not changed.
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To lock a segment:

 1. Select the segment to lock.

 2. Click Lock Segment on the Translation tab.

The Locked Segment icon appears in the Status column of the selected segment.
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Clearing Targets

To clear a target segment:

 1. Select the target segment.

 2. Click Clear Target on the Translation tab.

A confirmation message appears.

 3. Click Yes to clear the target.
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Clearing All Targets

To clear all content from the target segment:

 1. Click the Clear Target drop-down menu on the Translation tab.

 2. Click Clear All Targets.

A Warning message appears.

 3. Click Yes to clear all targets.

Unconfirming and Confirming Segments

The Unconfirm/Confirm Segment option allows the translator to mark a segment for future reference. For
example, if the translator wants to check and confirm a segment after referring to some resources, the
segment can be marked unconfirmed.

Unconfirmed segments cannot be committed to the TM.

Refer to the following tasks:

• Unconfirming or Confirming a Segment

• Unconfirming or Confirming All Segments

Unconfirming or Confirming a Segment

To unconfirm or confirm a segment:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Double-click the file or select and click Translate File.
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 4. Click the Translation tab.

 5. Enter a translation or leverage the target segment from the translation memory.

 6. Click Unconfirm / Confirm on the Translation tab.

The Unconfirmed icon appears next to the segment in the Status column.

 7. To confirm the segment, click Unconfirm/Confirm again.

The Unconfirm icon is removed from the Status column.

Unconfirming or Confirming All Segments

To unconfirm or confirm all segments:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Double-click the file or select and click Translate File.

 4. Click the Translation tab.

 5. Enter a translation for each segment, or leverage the target segments from the translation memory.
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 6. Click the Unconfirm / Confirm All drop-down menu.

 7. Click one of the following:
• Unconfirm All

• Confirm All
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The Unconfirm icon appears next to the segments in the Status column when Unconfirm All is
selected, as shown in the following example.

 8. Click Confirm All to reverse the Unconfirm All.

Editing Source Segments

The Edit Source option allows you to modify the source content of the file being translated. The original
source content is stored in the TXLF file and can be restored at any time.

To edit the source segment:

 1. Go to the Projects tab (refer to Opening Projects).

 2. Select and open the project.

 3. Double-click the file or select and click Translate File.

 4. Place the cursor within the segment source.

 5. Click Edit Source on the Edit tab.



Chapter 11 - Translating Files Wordfast

Copyright © Wordfast, LLC 2016.   Page 139 of 211

 6. Edit the source content as required.

 7. Click outside the edited segment.

The source segment is saved and an Edit Source icon appears in the Status column.

To revert to the original source, click Revert Source on the Translation tab.

Accented Characters

The table below lists the letters with supported accents.

Accent Sample Key Combination Notes

Acute Ó ó Ctrl+', V '= apostrophe key

V= any vowel
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Accent Sample Key Combination Notes

Circumflex Ô ô Shift+Ctrl+^, V

Grave Ò ò Ctrl+`, V

Tilde Ñ ñ Shift+Ctrl+~, V Only works with "n, N, o, O, a, A"

Umlaut Ö ö Shift+Ctrl+:, V := colon key

Some examples are:

1. To enter the character "ó", (Ctrl+',o) hold down the Control key and press the apostrophe key.
Release both keys and press "o". The accented letter appears.

2. To enter the character "Ó", (Ctrl+',O) hold down the Control key and press the apostrophe key.
Release both keys and press "O". The accented letter appears.

3. To enter character "ñ", (Shift+Ctrl+~,n) hold down the Shift key and press the Control key, then
press the tilde (~) key. Release all three keys and press "n".

The following table lists other supported foreign characters.

Character Name Key Combination Notes

¡ Upside-down exclamation
point

Alt+Shift+Ctrl+!  Press and hold Alt+Shift+Ctrl+!

¿ Upside-down question mark Alt+Shift+Ctrl+?  

Ç, ç French C cedille (caps/
lowercase)

Ctrl+, ,c

Ctrl+, ,C

For ç, press Control, then the comma
key. Release then press c.

Œ, œ OE ligature (caps/
lowercase)

Shift+Ctrl+&,o

Shift+Ctrl+&,O

Press and hold Shift+Ctrl+&, release
the keys and press o

ß German Sharp/Double S Shift+Ctrl+&,S

Ø, ø Nordic O slash (caps/
lowercase)

Ctrl+/,o

Ctrl+/,O

Å, å Nordic A-ring, Angstrom
sign (caps/lowercase)

Shift+Ctrl+@,a

Shift+Ctrl+@,A

A with ring/Angstrom Sign
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Character Name Key Combination Notes

Æ, æ Old English AE ligature
(caps/lowercase)

Shift+Ctrl+&,a

Shift+Ctrl+&,A

Ð, ð Old English eth (caps/
lowercase)

Ctrl+',d

Ctrl+',D

Icelandic/Old English eth

' = apostrophe key

Using Transcheck

The Transcheck option verifies the target segments and warns about missing or incorrect text or

variables. For example, if a tag or type text is incorrectly entered, a warning icon  appears before the
target segment. When you mouse over the warning, details appear.

The following are the related tasks:

• Enabling Transcheck

• Transcheck All
• Transcheck During Translation

• Viewing Transcheck Warnings

Enabling Transcheck

Transcheck options are tied to a specific project. To enable Transcheck and customize the options for a
project refer to Configuring Transcheck.

Transcheck During Translation

The Transcheck segments while translating option can be activated in Preferences to check for errors
during the translation process. When you translate a segment and commit to the TM, a Transcheck
warning will immediately pop up if there are any errors identified based on the configured Transcheck
options.

To Transcheck while translating:

 1. Open a file to be checked.

 2. Translate a segment and click Next Segment or Alt-Down.
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If a Transcheck error is found in the segment a warning message appears.

The Transcheck error explanation also appears in the Transcheck tab.

 3. Do one of the following:
• Click Go back to fix the issue to correct the error

• Click Continue to continue translating without changes

If the error is not corrected, the Transcheck error icon  remains in the Status column and the
Transcheck tab.

Transcheck All

The Transcheck All option scans all segments of a file for non-linguistic errors in the target segments
and warns about missing and incorrect text. This should be done before completing a file.

To check all segments of a file:

 1. Open a file to be checked.
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 2. Click the Review tab.

 3. Click Transcheck All.

All segments of the file are checked and a Transcheck report is generated.

Transcheck All Reports

After Transcheck is run on all segments, two reports are generated. The detailed Transcheck report
opens in a separate Web page and the summary is shown in a Transcheck Report pop-up.

The detailed Web report opens as shown in the following example, as long as pop-ups are not blocked
by the browser.
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Detailed Transcheck Report
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Summary Transcheck Report

 

Viewing Transcheck Warnings

Transcheck warning, explanation, and cause can be viewed under the Transcheck tab. Refer to
Configuring Transcheck.

To view Transcheck warnings:

 1. Open a file to check.

 2. Click the Review tab.
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 3. Click Transcheck All.

A summary of errors appears and an HTML report opens in the default browser.

 4. Click in the target segment with a Transcheck error status .
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 5. Click the Transcheck tab in the lower left panel.

The "(1)" indicates the number of errors found in the selected segment.

The Transcheck warning, explanation, and cause are displayed.

 6. Go to the next segment by clicking Next error on the Transcheck tab.

 7. Do one of the following:
• Correct the error and click Refresh

• Click Ignore warning to continue reviewing the warnings without changes

If the error is not corrected, the Transcheck error icon  remains in the Status column and under the
Transcheck tab.

Enabling Machine Translation

Wordfast Pro includes an automated machine translation feature that populates translations whenever
a file is open or when there are no translation memory segment matches. To enable specific Machine
Translation options, refer to Configuring Machine Translation.
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Using Auto-Suggest

The Auto-Suggest option populates suggestions based on source content, such as numbers, URLs and
proper names. It can also suggest terms for the glossary, translation memory (TM) matches, and sub-
segment TM matches. To enable Auto-Suggest, refer to Configuring Text Tools.

Leveraging Repetitive Content

Leveraging repetitive content re-uses segments that are repeated in a file. In the following example there
are multiple instances of the phrase Seamless Database Integration, so when the translator enters the
translation the duplicate segment is populated as well. Refer to Configuring Auto-Propagation.

To leverage repetitive content from the TXLF Editor Translation tab:

 1. Open a file for translation.

 2. Select the first translatable segment.

In this example, the duplicate segments have been located with a filtered search.
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 3. Enter the translation into the first segment.

 4. Commit the term by using one of the following methods:
• Click Commit

• Click Next Segment or press Alt+Down
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The entered target segment is saved to the TM and automatically propagates this target segment for
all repeats of the source segment throughout the file.

Saving Files

It is a good practice to save your work occasionally to prevent a loss before completion. The options to
save files are available on the Files tab.
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To save your work use one the options below.

 • On the File tab, click one of the following:
• Save to save the active file to  a local folder manually

• Save to save the active file to a local folder manually under a different name

• Save File As Translated to save the translated file to a local folder

A pop-up progress bar appears and upon completion, you will find the saved file on a local folder.
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Quick Tools 12
Quick Tools provides a collection of tools for users to create and work with files outside of projects.
These tools are primarily used by Project Managers before sending the files to translators.

 1. Open Wordfast Pro.

 2. Click the Wordfast 4 tab to expand the drop-down menu.

Refer to Starting Wordfast Pro for more information.

 3. Click Quick Tools.

Refer to the following sections for more information on Quick Tools:

• To run a project file analysis, refer to Analyzing Project Files
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• To clean up and update the Translation Memory, refer to Cleanup

• To preview what is translatable and the complexity of formatting in the target, refer to Pseudo
Translation

• To complete bilingual export of files, refer to Bilingual Export

• To complete bilingual import of files, refer to Bilingual Import

Analyzing Project Files

In analyzing a project's files for translation, the source files are analyzed against Translation Memory and
generates a report listing matches, non-matches, word count, and character count as well as the total
number of segments.

The file Analysis can also create TXLF files from the source files that can then be sent to linguists for
translation.

Another use of the file Analysis is in generating quotes based on the word and character count.

Analysis can be accomplished in either of the following ways:

• Analyzing files within a project from the Project Files tab, refer to Analyzing Projects

• Analyzing files from the Quick Tools tab, refer to Analyzing Files

Analyzing Files

To analyze files:

 1. Select Quick Tools from the Wordfast 4 drop-down menu.

 2. Click the Analysis tab.
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 3. To add files, do one of the following:
• Click Add File to browse and select a file from a folder. To add multiple files, press the Ctrl key

and select the files.

• Click Add Folder to browse and select a folder and add all files within.

• Drag and drop files into the Source Files panel.

The files appear in the Source Files panel.

 4. Add and select the Translation Memory.

 5. Select the Options:

• Fuzzy match threshold: Select the percentage of match

• Copy all tags

• Copy source on no match

• Create TXLF files

• TXLF file location: Browse and select the location to save the TXLF files

 6. Select the Report Settings:

a) Calculate analysis report percentage by:

• Words
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• Segments

b) Select to Calculate internal fuzzy matches with the percent match.

• Select Include internal fuzzy matches as TM matches

c) Select the report format from the drop-down list, and browse to select a location to save the report.

 7. Click Analyze Files.

The Report File appears and the report summary in the chosen format is saved in the selected
location.

Cleanup

The Project Manager is responsible for cleaning up translated files and selecting the TM update options.

Cleanup processes bilingual TXLF files containing source and target. The bilingual files are converted
into their original format in the target language. Refer to Working with Segments.

Optionally, the TM can be updated during cleanup.
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As a final step, a report is generated indicating the number of segments processed, errors encountered,
and TM update results.

To clean up and update the translation memory:

 1. Select Quick Tools from the Wordfast 4 drop-down menu.

 2. Click the Cleanup tab.

 3. To add files, do one of the following:
• Click Add File to browse and select a file from a folder. To add multiple files, press the Ctrl key

and select the files.

• Click Add Folder to browse and select a folder and add all files within.

• Drag and drop files into the TXLF Files panel.

The files appear in the TXLF Files panel.

 4. Add and select the Translation Memory.

  Note:

At least one Translation Memory is needed before file clean up can be initiated (refer to Project
TM). To add a local or remote Translation Memory, refer to Creating Local TMs for more
information.

 5. (Optional) Select the TM Update Options:
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• Update Option: Select one of the TM update options

• Add attribute: Select and enter an attribute to be added to the cleaned up segments

• Add file name as an attribute: Select to add the TXLF file name as an attribute to the cleaned
up segments

• Write unedited fuzzy matches to the TM

• Write unedited 100% matches to the TM

 6. (Optional) Select the Translation File Settings:

• Create Translated Files: Select to generate final files in original format

• Place translated files in TXLF location: Select to save the translated files in the same folder
location as the TXLF files

• Choose location for translated files: Select to browse and select a location for the translated
files

• Add language suffix for file name: Select to add the translation language code to the file
name suffix

• Cleanup Report: Select the report file format and browse and select the location to save it

 7. Click Clean Up.

The CleanUp Report appears. The translated files and the report summary in the chosen format are
saved in the selected location.

Pseudo Translation

Pseudo translation copies the source content to the target where the content has accented characters
and the text is expanded by twenty percent. The pseudo translation provides a preview of what content
will be selected as translatable and how complex formatting appears in the target. Both source files and
the TXLF files can be pseudo translated.
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To pseudo translate files:

 1. Click Quick Tools in the Wordfast 4 drop-down menu.

 2. Click the Pseudo Translation tab.

 3. Select the file type for pseudo translation:
• TXLF: Select and add a TXLF file

• Source: Select and add source files, select Source Language, Target Language and Pseudo
translation Options

 4. To add files, do one of the following:
• Click Add File to browse and select a file from a folder. To add multiple files, press the Ctrl key

and select the files.

• Click Add Folder to browse and select a folder and add all files within.

• Drag and drop files into the Files panel.

The files appear in the Files panel.

 5. Select the files to be pseudo translated.

  Note:

Only one file type, either TXLF or Source can be selected at a time.

 6. Click Pseudo Translate.
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A confirmation message appears upon completion.

  Note:

Up to 20 files can be processed at a time using Wordfast Pro in Demo mode. To pseudo translate
more than 20 files, a Wordfast Pro license is required.

The pseudo translated files are placed in the selected folder location.

Bilingual Export

Bilingual Export is used for translating outside of the application. The Bilingual export option allows you
to export the TXLF file with highlighted glossary terms into a DOC format and edit using Microsoft Word.

To complete bilingual export of files:

 1. Select Quick Tools from the Wordfast 4 drop-down menu.

 2. Click the Bilingual Export tab.
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 3. To add files, do one of the following:
• Click Add File to browse and select a file from a folder. To add multiple files, press the Ctrl key

and select the files.

• Click Add Folder to browse and select a folder and add all files within.

• Drag and drop files into the TXLF Files panel.

The files appear in the TXLF Files panel.



Chapter 12 - Quick Tools Wordfast

Copyright © Wordfast, LLC 2016.   Page 161 of 211

 4. To add a glossary, do one of the following:
• Click Add Local to browse and select a local glossary.

• Click Connect To Remote to connect to a remote glossary.

• Click Add Project Terminologies to select glossaries associated with projects.

The glossaries appear in the Glossaries panel.

 5. Select the TXLF files and glossaries for bilingual export.

 6. Select the Bilingual Export Options.
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Option Description

Export Type • Bilingual Review Export: creates a bilingual Word
document

• WFC Bilingual Export: creates a WF Classic compatible
document

• MS-Word Table: creates an Word document with the
source and target in a two-column table

Open report after export Automatically displays the Export Report after the Bilingual Export
action

Exclude the notes column Removes the Notes column from the exported Word document.
When removed, the notes from the TXLF file are displayed in the
Word document as Comments

Track changes Selects track changes in the exported Word document

Protect document (Word
2003+)

Protects the Word document by allowing editing of content only in
the available table space. This helps avoid any errors when the
document is imported.

Export all TXLF files as one
bilingual file

Exports all TXLF files that are being converted to bilingual Word
documents

Bilingual File Location Browse and select the folder to save the bilingual export
documents

 7. Click Bilingual Export.
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The log appears. This log and the exported document in the chosen export type are saved in the
selected folder.

  Note:

You must not edit the table format, merge or expand segments or add text outside of the target or
notes column. Doing any of these actions could result in errors during bilingual import.

A sample of the bilingual export is given below.
 

Bilingual Import

Bilingual Import is used for importing the translated or edited bilingual exported Word document. During
this import you must add both the edited bilingual Word document and the corresponding TXLF file that
was used during export. Once the bilingual import is complete, the translations or edits made in the
bilingual exported Word document are reflected in the TXLF file.

To complete bilingual import of files:

 1. Select Quick Tools from the Wordfast 4 drop-down menu.

 2. Click the Bilingual Import tab.
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 3. To add files, do one of the following:
• Click Add File to browse and select a file from a folder. To add multiple files, press the Ctrl key

and select the files.

• Click Add Folder to browse and select a folder and add all files within.

• Drag and drop files into the Bilingual Files and TXLF Files panels.

  Note:

You must upload both the translated or edited bilingual Word document and the source TXLF
file. When adding files, remember to select the correct file format from the drop-down list. You
must select MS Word Document when uploading the bilingual Word document and WF TXLF
Document when uploading the TXLF file.
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The files appear in the Bilingual and TXLF Files panels.

  Note:

• The Bilingual Files panel displays the File Name, File Type, Size and Counter. The first
number in the Counter indicates the count of TXLF files in the bilingual file that are paired
with the added files in the TXLF Files panel. The second number indicates the total count of
TXLF files that were used during Bilingual Export.

• The TXLF Files panel displays the File Name, Source Language, Target Language, Size and
Paired. When the bilingual Word document and the corresponding TXLF file are paired, a

green check  appears. If the files are not paired, a red cross  appears.

 4. Select the Bilingual and TXLF files for bilingual import. To select multiple bilingual files, press the Ctrl
key and select the files.

 5. Select the Bilingual Import Options.

Option Description

Open report after import Automatically opens the Import Report after the
Bilingual Import action

Accept Tracked Changes Accepts tracked changed in the bilingual Word
document

 6. Click Bilingual Import.
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The log appears. The translations and edits in the bilingual Word document are imported into the
selected TXLF file.

  Note:

The TXLF file will be overwritten with the content in the imported bilingual Word document. It is
recommended to create a backup of the original TXLF file for reference.
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Preferences 13
The Wordfast Pro user interface is controlled by the preference options. You can configure these
through Preferences and by pressing F9.

The preferences categories are listed below:

• General Preferences

• Translation Preferences

• Current/New Project Preferences

• User Preferences—Advanced Settings

General Preferences

General preferences cover the following topics:

• Customizing Colors

• Customizing Icon Appearance

• Customizing Shortcuts

• Customizing Fonts

• Customizing Application Layout

• Customizing Warnings

Customizing Colors

Varying colors are used to differentiate between types of content in the TXLF editor. This color usage
can be customized through Preferences—General Preferences.

To customize the color usage for translation from Preferences:

 1. Click Colors in the General Preferences group.
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The current translation color settings appear.

 2. To change the color for any Item Name, click the colored image in the Color column.

For example, click the colored image in the Color column for item Auto-Propagated , and select
another color in the color palette.
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The color code for the selected item is changed to the new color.

 3. Click OK to save the change(s) and close the Preferences.

Customizing Fonts

The fonts for the various application tools can be customized in the Preferences—Fonts section.
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The following tables list the standard fonts and associated sizes.

Application Specific Fonts

Application Font Name Font Size

TXLF (TXML) Editor Font Arial 13

TM Lookup Font Arial 12

Glossary Lookup Font Arial 12

Blacklist Editor Font Arial 13

Translation Memory Editor Font Arial 13

Terminology Editor Font Arial 13

Notes View Font Arial 12

Segment History Font Arial 12
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Application Font Name Font Size

Transcheck Font Arial 12

Adding Language Specific Fonts

Language Font

Bengali Bangla

Malayalam Kartika

Telugu Gautami

Tamil Latha

Kannada Tunga

Afrikaans Arial

Afrikaans (South Africa) Arial

Chinese SimSun

Chinese (Taiwan) PMingLiU

Chinese (China) SimSun

Hebrew Arial

Hebrew (Israel) Arial

Japanese MS Gothic UI

Japanese (Japan) MS Gothic UI

Korean Batang

Thai Tahoma

Thai (Thailand) Tahoma
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Language Font

Vietnamese: Arial Arial

Vietnamese (Vietnam): Arial Arial

Customizing Icon Appearance

The icons appearance on the various tabs can be modified to the extent of relative size and the inclusion
or exclusion of the icon title by going to Preferences then Icons as described below.

To customize the icon appearance from Preferences:

 1. Click Icons.

The two icon appearance options appear.

 2. Select a preferred icon size.

 3. Select Display text to enable or disable the inclusion of description text with the icons.
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Customizing Application Layout

The layout preferences provide some control of the Editor view. Customize the general layout options by
going to Preferences then:

 1. Click Layout.

The layout preferences appear.

 2. Modify the layout options as follows.

Table View

Option Description

Hide ID Column Hide the segment ID column.

Hide Score Column Hide the Translation Memory score column.

Hide Table Header Hide the editor table header.

Score Column Position
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Option Description

Before Target Place the Translation Memory score column before the target
segment column.

After Target Place the Translation Memory score column after the target
segment column.

Segment

Option Description

Automatically leverage first segment View the Translation Memory leverage of the first open
segment when you open a TXLF file for translation.

Automatically open last edited
segment when opening a file

Go to the last segment edited when a file is opened.

Next/Previous Segment (TM
Commit) action leverages next/
previous segment

Enable or disable the writing and leveraging action of the
Next/Previous Segment command.

Skip Unedited 100% Matches Enable or disable skipping over those segments with perfect
matches.

Skip Unedited Context Matches Enable or disable skipping over those segments with context
matching.

Layout

Option Description

Keep the last layout open Always keep the previous edit view open.

Layout—Current Project

Option Description

Display Locale Codes in Current
Project View

Always include locale information in the view for current
projects.



Chapter 13 - Preferences Wordfast

Copyright © Wordfast, LLC 2016.   Page 175 of 211

Option Description

Display Full Language Name in the
Current Project View

Always include the complete language name in the view for
current projects.

Status Bar—Current Project

Option Description

Language Codes Include the language codes on the Status Bar.

Full Language Name Include the complete language name on the Status Bar.

Customizing Shortcuts

Many of the tools of Wordfast can be associated with keyboard shortcuts.

To view the list of available shortcuts and select keyboard shortcuts, go to Preferences and then:

 1. Click Shortcuts in the General Preferences group.

The options list to customize keyboard shortcuts appears for the Application scheme.

 2. Select a scheme from the Scheme drop-down list.

 3. Select a Command from the command list.

In the example below, the Terminology Highlight shortcut is selected.
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 4. Select that command to access edit mode.

 5. Press the new sequence of keys, such as Ctrl+Shift+F7 in the Shortcut column.

If the shortcut key sequence is in use a warning pop-up appears.

The shortcut key is modified to the new sequence.

  Note:

When changing or creating new shortcut key sequences, the sequence must begin with a Ctrl, Alt,
or Shift, or must be a Function key (F1), a combination of these.

 6. Click OK.
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Customizing Warnings

The messages that are presented to the user can be limited to some extent. Most of the messages
—referred to here as warnings—are selected by default. To modify the warning inclusion list, select
or deselect the check box for a given warning to enable or disable that warning. To customize the
messages presented, go to Preferences.

To select warnings:

 1. Click Warnings.

The Warnings dialog box appears.

 2. Select the warnings to be displayed in the application.

Translation Preferences

The Translation Preference categories are:

• Configuring Tags

• Configuring Text Tools

• Configuring Spell Check

• Configuring Auto-Propagation

• Configuring Machine Translation

Configuring Tags

Configure the tag mode, representation, and font size by going to Preferences then Tags as described
below.
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  Note:

The project as configured in Project Director (PD) may not support formatting tags.

To modify tag settings from the Preferences option:

 1. Click Tags under Translation Preferences.

The Tags options list appears.

 2. The tag options are listed in the following tables. Modify the options as required.

Text Formatting

Tag Option Description

Show Text Formatting Show actual formatting associated with formatting tags (when
supported). When selected, a preview appears.

Show Formatting as Tags Show the content of the formatting tags. When selected, a preview
appears, as shown in the example above.

Tag Naming
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Tag Option Description

Full Name View full name of the tag. For example, Font.

Short Name View short name of the tag. For example, F.

Numbering View the tag as a number.

Automatically remove
incomplete tag pairs

Delete incomplete or incorrect tags.

Automatically apply
segment formatting

Automatically apply formatting to the entire segment.

Capitalize First Letter Capitalize the first letter of the first word in the segment.

White Space Character

Tag Description

Display spaces and NBSPs
in the editor

Show all spaces including non-breaking white spaces as a middle
dot (·).

Configuring Auto-Propagation

Auto-Propagation allows repetitive content in the file to be translated consistently, by propagating
translated segments. The Auto-Propagation options control which segments are candidates for auto
propagation.

To edit the Auto-Propagation preferences from Preferences:

 1. Click Auto Propagation.
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The Auto-Propagation preferences options list appears.

  Note:

The options listed below are only available when Auto-Propagation is enabled.

 2. Deselect Enable Auto-Propagation to disable Auto-Propagation.

 3. Select Enable Auto-Propagation across all open files to apply auto-propagation to all open files.

 4. Review the Auto-Propagation options to ensure that those required are the only ones selected. The
options are described in the following table.

Option Description

100% Matches Overwrites 100% leveraged Translation Memory (TM) matches.

Fuzzy Matches Overwrites partial Translation Memory matches.

Auto-propagated
Matches

Overwrites all auto-propagated matches. This means that if there are
multiple segments that have the same content, then editing one segment
auto-propagates the change in all matching segments.
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Option Description

Edited Segments Overwrites edited segments. This allows segments that have been edited
to be overwritten by Auto-Propagation.

Machine Translated
Segments

Overwrites machine translated content.

Committed Segments Overwrites translated content which is committed to the Translation
Memory (TM).

Configuring Text Tools

The Text Tools preferences offer the following configuration options for the text editor:

• The Auto-Suggest option populates suggestions based on source content, such as numbers,
URLs, and proper names. It can also suggest terms for the glossary, Translation Memory (TM)
matches, and Sub-segment TM matches.

• The Smart Quote option automatically changes the quotation marks to smart quotes when the
user presses the quotation mark keys on the keyboard, depending on the target language.

To configure the text editor options, navigate to Preferences and then:

 1. Click Text Tools.
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The options for the text editor appear.

 2. Select Enable Auto-Suggest checkbox, to enable Auto-Suggest.

With Auto-Suggest enabled, there are four options under Enable suggestions for:

a) Click Source to enable suggestions for sources of the segment: numbers and capitalized words
only.

b) Click Glossary to enable suggestions for terms from the glossary.

c) Click TM to enable suggestions for translations from the TM.

d) Click TM Sub-Segment to enable suggestions for parts of segments from the TM.

 3. Select Enable Smart Quotes checkbox to enable automatic conversion of standard quotes to smart
quotes (quotation marks).

Depending on the target language, the quotation marks used when the user presses the quotation
mark keys on the keyboard are changed.

Configuring Spell Check

Selecting the spell check option is a good practice to ensure that the translated content is of high quality.
Spell check is supported in Microsoft Office and Hunspell.
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To enable or disable spell check go to Preferences and then:

 1. Click Spellchecker.

The Translation Preferences for Spellchecker options appear. If this is a new project, the default,
Enable Spell Checking, is enabled.

 2. Select or deselect Enable Spell Checking.

 3. If Check for spelling errors as you type is selected, choose one of the following:
• Microsoft Office

  Note:

Microsoft Office must be installed on your computer.

• Hunspell

  Note:

Hunspell dictionaries are available for the following languages. Any of these languages can be
installed by going to Help > Wordfast 4 Update, choosing the required language JAR and clicking
Update.
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Table 1:

Language Shortcode Language Shortcode

Arabic AR Korean (South Korea) KO-KR

Basque (Basque) EU-ES Latvian (Latvia) LV-LV

Bosnian (Bosnia) BS-BA Lithuanian (Lithuania) LT-LT

Bulgarian (Bulgaria) BG-BG Norwegian (Bokmål
Norway)

NB-NO

Catalan (Catalan) CA-ES Norwegian (Nynorsk
Norway)

NN-NO

Croatian (Croatia) HR-HR Polish (Poland) PL-PL

Czech (Czech
Republic)

CS-CZ Portuguese (Brazil) PT-BR

Danish (Denmark) DA-DK Portuguese (Portugal) PT-PT

NL-NL Romanian (Romania) RO-RO

English (Canada) EN-CA Russian (Russia) RU-RU

English (United
Kingdom)

EN-GB Scottish Gaelic (United
Kingdom)

GD-GB

English (United States) EN-US Serbian (Serbia) SR-RS

Estonian (Estonia) ET-EE Slovak (Slovakia) SK-SK

Farsi (Iran) FA-IR Slovenian (Slovenia) SL-SI

Finnish (Finland) FI-FI Spanish (Mexico) ES-MX

French (Canada) FR-CA Spanish (Spain) ES-ES

French (France) FR-FR Swedish (Sweden) SV-SE
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Language Shortcode Language Shortcode

Galician (Spain) GL-ES Swahili (Kenya) SW-KE

German (Germany) DE-DE Tagalog (Philippines) TL-PH

Greek (Greece) EL-GR Thai (Thailand) TH-TH

Hebrew (Israel) HB-IL Turkish (Turkey) TR-TR

Hindi (India) HI-IN Ukrainian (Ukraine) UK-UA

Hungarian (Hungary) HU-HU Urdu UR

Italian (Italy) IT-IT Vietnamese (Vietnam) VI-VN

Irish (Ireland) GA-IE Welsh (United
Kingdom)

CY-GB

Kazakh (Kazakhstan) KK-KZ Zulu (South Africa) ZU-ZA

 4. Click OK to save the settings.

  Note:

If spell checking is disabled, all spelling preferences are cleared. To select spelling preferences,
select Enable Spell Checking.

Configuring Machine Translation

The automated Machine Translation (MT) feature populates translations whenever a file is open or when
there are no Translation Memory segment matches.

To enable Machine Translation and select options, navigate to Preferences and then:

 1. Click Machine Translation.
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The Machine Translation options appear.

 2. Select one of the following:
• Perform when there is no TM match, to show machine translated content when there are no

match segments.

• Always perform Machine Translation, to show machine translated content when a segment is
leveraged. TM matches appear in TM Lookup with the MT matches.

 3. Select check boxes to allow all unedited segments in active document to be leveraged with MT, and
to remove MT score from score column when segment is edited.

 4. Select Google Translate, Microsoft Translate, or WorldLingo as primary machine translator. Google
Translate, Microsoft Translate, and WorldLingo can all be enabled at one time, but only one can be
selected as primary machine translator.

 5. Select the options for each machine translator, and perform any additional tasks as required by the
machine translator.
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Translator Options

Enable Google
Translator

Enable Microsoft
Translator

Enable
WorldLingo

Languages are limited to WorldLingo Languages listed below.

 6. Read the disclaimer carefully.

 7. Click OK.

WorldLingo is limited to the language set listed below:

• Arabic

• Chinese Simplified

• Chinese Traditional

• Dutch

• English

• French

• German

• Greek

• Italian

• Japanese

• Korean

• Portuguese

• Russian

• Spanish

• Swedish

Current/New Project Preferences

If this is being accessed for a new project, the preferences are all set as defaults. For current projects,
the preferences reflect whatever has been set up for this project by the Project Manager. These
preferences cover the following topics:
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• Configuring Translation Memory

• Configuring Penalties

• Configuring Segmentation

• Configuring Terminology

• Configuring Transcheck

• Configuring Filters

Configuring Translation Memory

To configure Translation Memory settings for a project from Preferences:

 1. Click Translation Memory.

The Translation Memory options list for the current project appears.

The following steps apply to the Translation Memory section.
 2. Select Write unedited fuzzy and exact matches to TM, to commit unedited fuzzy and 100%

matches to a TM.
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 3. Select Copy source when..., to copy the source to the target segment when there is no match and
the TM is leveraged.

 4. Select the Fuzzy Match Threshold percentage.

  Note:

This value specifies the TM leverage percentage limit for a fuzzy match. For example, if a value of
75% is entered, the tool marks all the translations which are leveraged below 75% match as a 'No
match' segment.

 5. Select the analysis Report Settings:
• Calculate analysis report Percentage by: Words or Segments

• Calculate Internal Fuzzy Matches in: Percentage and Include Internal Fuzzy Matches in TM
Matches

 6. Select only one condition to be followed when editing an existing Translation Unit. The options are as
follows:
• Add to TM by overwriting the existing TU (default): Overwrite the existing Translation Unit

• Add to TM; overwrite the existing TU if attributes are identical: Overwrite the existing
Translation Unit if the attributes match

• Only add to TM the new TU; do not overwrite the existing TU: No overwrite, just add new TUs
to the existing Translation Unit

• Add to TM; do not overwrite the existing TU: No overwrite, just add TUs to the existing
Translation Unit

• Do not add to TM: No addition to be made to the existing Translation Unit

 7. Select the Number of TM lookup hits.

The following steps apply to the Replaceables section.
 8. Select Enable replaceables for higher TM matches to replace the selected segments in the

translation with segments from the selected TM.

Selecting this option selects all sub-options by default. Select or deselect the terms to be replaced or
not to be replaced from the Translation Memory as listed below:

a) Deselect Number replacement if not wanted

b) Deselect URL replacement if not wanted

c) Deselect Punctuation replacement if not wanted

d) Deselect Email address if not wanted

 9. Click OK.

The Translation Memory properties for the project are set up.
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Configuring Terminology

Terminology lists or glossaries are used to leverage previously translated text, resulting in lower costs
and greater consistency.

To select Terminology options for a project from Preferences:

 1. Click Terminology in the Current Project Preferences group.

The Terminology (Glossary) preferences appear.

 2. Select Enable Fuzzy Terminology, to view fuzzy matches.

 3. Select the number of matches to be viewed.

 4. Select Enable term highlighting as you type, indicate terminology matches by highlight when
entered in the translation.

 5. Select Ignore case for term highlights, to ignore case difference in terminology matches.

 6. Click OK.

Configuring Penalties

Penalties are defined to maintain a high quality of content leveraged from Translation Memory. A relative
value is assigned to each of the penalties, which are then taken into account when calculating the
translation score. This score is used to differentiate between golden or 100 %, fuzzy, and no match.
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To define penalties for a project from Preferences:

 1. Click Penalties.

The Penalties preferences for the current project appear.

 2. Select the categories desired and supply their thresholds. The following table shows a list of penalties
with their descriptions.

Penalty Description

Case Differences in case is considered

Non Literal Differences in special characters, including punctuation, space,
apostrophe, dash, quote, etc

Tag Differences in tagging

Whitespace Differences in blank spacing
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Penalty Description

Align Differences in Translation Units with alignment attributes

Machine Translation Differences in Translation Units based on Machine Translation

Multiple Translation Differences in Translation Units based on duplicates within the TM with
different translations

Local TM Differences in Translation Unit from local desktop copy

Remote TM Differences in Translation Unit from remote TM

Private TU Differences in work-group Translation Unit from remote TM

Public TU Differences in non-work-group Translation Unit from remote TM

Secondary TM Indicates more than one TM is permitted and includes the maximum as
selected

Attribute Differences in attributes

If Attribute is Not When custom attribute in the Translation Unit does not match the text box
attribute

If Filename Attribute
Does Not Match

When the file name attribute in the Translation Unit does not match the
TXLF file name

 3. Click OK.

Configuring Transcheck

Transcheck verifies a translation for missing or incorrect text or variables. Its configuration is specific to
a given project. For example, if a tag is missing or incorrect text was entered, a warning symbol appears
before the target segment. The warning is shown when you mouse over the text.

To configure the Transcheck options from Preferences:

 1. Click Transcheck under Current Project Preferences.

The Transcheck options appear. In the following image only the base options are shown. Many
options present additional related options when they are selected.
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 2. To control how Transcheck checks target segments, select the different configuration settings.

Setting Description

Transcheck segments
while translating

Check to enable Transcheck during translation

Select/Deselect All Check to enable all of the following options

Blacklist Check Check if the target segment includes blacklisted terms.

Note: The blacklisted term list must be a tab-delimited file. This check is
available depending on the TMGR configuration for the project. Refer to
Configuring Blacklist Check

Capitalization Check Check differences in capitalization. To configure this option, refer to
Configuring Capitalization Check

Edited Context Match
Check

Check if context matches from the TM were edited
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Setting Description

Edited Exact Match
Check

Check if exact matches from the TM were edited

Edited Source Check Check if the source of a segment was edited

Empty Target Check Check for segments containing no translation

Forbidden Character
Check

Check if the target segment includes forbidden characters. Refer to
Configuring Forbidden Characters Check

Number Difference
Check

Check if the numerals in the source segment match the target segment.
Refer to Configuring Number Difference Check

Paragraph Length
Check

Check if the target paragraph length has exceeded the maximum
character length set for the paragraph

Punctuation Check Check for consistency in punctuation between source and target
segments. Refer to Configuring Punctuation Check

Repeated Word Check Check for repeated words in the translation

Segment Length
Check

Check if the translation complies with preset limits on characters and
words. Refer to Configuring Segment Length Check

Extended Punctuation
Check

Check for consistency in extended punctuation between source and target
segments

Copied Source Check Check for copied source text in the target. Refer to Configuring Copied
Source Check

Spelling Check Check spelling as the translation is entered. Refer to Configuring Spell
Check

Tag Check Check for missing tags in the target segments. Refer to Configuring Tag
Check

Terminology Check Check if the terms in the source segment are translated correctly based
on the terminology list. Refer to Configuring Terminology Check
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Setting Description

Unconfirmed Segment
Check

Check if segment is marked unconfirmed

Unedited Fuzzy Check Check if fuzzy matches were not edited

Unedited MT Check Check if machine translated matches were not edited

Untranslatable Text
Check

Check if the untranslatable content in source and target segments is
consistent. Refer to Configuring Untranslatable Text Check

Untranslated Text
Check

Check if any segments are not translated; for example, if Copy Source
was used to enter translation

Whitespace Check Check for mismatched or double white spaces in the target segment.
Refer to Configuring Whitespace Check

 3. Click OK.

The Transcheck configuration is complete and active for the current project.

Configuring Blacklist Check

To configure the checking for blacklisted words for a given project from the Preferences option:

 1. Click Transcheck.

 2. Select Blacklist Check.

The related options appear.

 3. Select the appropriate options.

Option Description

Skip exact matches Do not check the blacklist when there is an exact match

Skip context matches Do not check the blacklist when there is a context match



Chapter 13 - Preferences Wordfast

Copyright © Wordfast, LLC 2016.   Page 196 of 211

Configuring Capitalization Check

To configure the checking for capitalization differences for a given project from the Preferences option:

 1. Click Transcheck.

 2. Select Capitalization Check.

The related options appear.

 3. Select the appropriate options.

Option Description

All Caps Mismatch Check text in the target that is all in upper case, when the
source is not all in upper case

First Word Case Difference Check Check the first letter of the first word is capitalized consistently
in source and in target

Target Capitalization Mismatch
Check

Check upper case text in the target that is in lower case in the
source

Source Capitalization Mismatch
Check

Check upper case text in the source that is in lower case in
the target

Skip exact matches Disable or enable checking for capitalization on exact
matches

Skip context matches Disable or enable checking for capitalization on context
matches
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Configuring Forbidden Characters Check

To configure the checking for forbidden characters from the Preferences option:

 1. Click Transcheck.

 2. Select Forbidden Character Check.

The forbidden characters check is enabled.

 3. Click Add to add or edit a forbidden character.

Add a character to be forbidden over the NEW character string.

 4. Click Update.

To remove a forbidden character from Forbidden Character checking, highlight the character and
click Remove.
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Configuring Punctuation Check

Punctuation Check ensures consistency in punctuation between source and target segments.

To configure punctuation checking from the Preferences dialog box:

 1. Click Transcheck.

 2. Select Punctuation Check.

A list of current punctuation characters appears.

 3. Click Add to add a new character to the default list of punctuation characters.

 4. Click Update.

To remove a punctuation character from checking, highlight the character in the list and click
Remove.

 5. Select any of the following options:
• Double Punctuation Check to check for repeated punctuation

• Skip exact matches to disable or enable checking for punctuation on exact matches

• Skip context matches to disable or enable checking for punctuation on context matches

 6. Click OK.
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Configuring Number Difference Check

To configure the number difference check for this session from the Preferences option:

 1. Click Transcheck.

 2. Select Number Difference Check.

The related option appears.

 3. Select any of the following options:
• Treat numbers separated by hyphens and dashes as single number to accept hyphenated

numbers as one

• Skip exact matches to disable or enable checking for number differences on exact matches

• Skip context matches to disable or enable checking for number differences on context matches

 4. Click OK.

Configuring Segment Length Check

Check if the translation complies with preset limits on character and word count.

To customize the segment-length checking function from the Preferences option:

 1. Click Transcheck.

 2. Select Segment Length Check.

 3. Select those options that apply.

The options are explained in the following table.
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Option Description

Strict Character Length Check (Zero means
unlimited)

Check minimum and maximum character length.

Character Expansion Check Check minimum and maximum character
expansion, as a percentage.

Word Expansion Check Check minimum and maximum word expansion,
as a percentage.

Attribute Character Max Length Check Check attribute text that exceeds the maximum
character length set in Project Director.

Skip exact matches Disable or enable checking for segment length
on exact matches.

Skip context matches Disable or enable checking for segment length
on context matches.

Configuring Copied Source Check

To customize the copied source checking operation from the Preferences option:

 1. Click Transcheck.

 2. Select Copied Source Check.

The related options appear as shown.

 3. Select select any options that apply from the following list:

• Skip exact matches when checking for copied source

• Skip context matches when checking for copied source

• Skip tokens when checking for copied source
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Configuring Spell Check

To customize the spell checking operation from the Preferences option:

 1. Click Transcheck.

 2. Select Spelling Check.

The related options appear as shown.

 3. Select select any options that apply from the following list:

• Skip exact matches when checking for spelling

• Skip context matches when checking for spelling

Configuring Tag Check

To customize the Tag checking operation from the Preferences option:

 1. Click Transcheck.

 2. Select Tag Check.

The related options appear as shown.

  Note:

The project may not be configured in Project Director (PD) to permit formatting tags.

 3. Select any options that apply from the following list:

• Check for non-formatting tags

• Check for Source formatting missing in target

• Check for formatting that exists in target but not in source

• Skip exact matches when checking for tags
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• Skip context matches when checking for tags

Configuring Terminology Check

To configure the Terminology checking criteria from the Preferences option:

 1. Click Transcheck.

 2. Select Terminology Check.

The options appear.

 3. Select any of the following options that apply.
• Enforce Term Case: Check based on exact case matching

• Fuzzy Term Check: Include terms that approximately match

• Skip exact matches when checking for terminology

• Skip context matches when checking for terminology

Configuring Untranslatable Text Check

To configure the handling of untranslatable text checking from the Preferences option:

 1. Click Transcheck.

 2. Select Untranslatable Text Check.
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The Untranslatable Text Check expands to a dialog box.

 3. To retain the untranslatable text in the target segment, click Add.

 4. Enter the untranslatable text to be retained.

 5. Enter a custom regular expression as necessary.

 6. To remove untranslatable text from the check, highlight the text in the list and click Remove.

 7. Select any of the following options that apply:
• Skip exact matches when checking for untranslatable text

• Skip context matches when checking for untranslatable text

Configuring Whitespace Check

To configure white-space for this session from the Preferences option:

 1. Click the Transcheck.

 2. Select Whitespace Check.

The options appear.
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 3. Select any of the following options that apply.

• Skip exact matches when checking for white space

• Skip context matches when checking for white space

Configuring Segmentation

These preferences specify how files should be segmented by the TXLF editor for a given project.

 1. Open Wordfast Pro and select a project from the project list.

 2. Click Open Project.

 3. Click Preferences under Options.

The overall preferences setup panel appears.

 4. Click Segmentation in the Current Project Preferences section.

The Segmentation options appear.

 5. Select the required segmentation options. These options are:
• Select Segmentation on break to enable segmentation on line breaks.

• Select the Segmentation Type as APPLICATION or SRX from the drop-down list.
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 6. Define the characters that end a segment (ESM):
• Enter specific characters into the input field to specify custom segment end characters

• Select Space to enable white-spaces as a segment end character

• Select Tab to enable tabs as a segment end character

• Select Non Breaking Space to enable non-breaking white-spaces as a segment end character

• Select Line Feed to enable line-feed ASCII codes as a segment end character

• Select Carriage Return to enable carriage return ASCII codes as a segment end character

 7. Define the rules for the markers, select those that apply:
• A number followed by an end of a segment marker.

• Segment ends in a segment marker without a trailing space character.

• Segment ends in a segment marker, followed by a space character and a lower-case letter.

 8. Select abbreviations that should not be used in segmenting. See the following dialog box segment.

Configuring Filters

There are common file filters that can be enabled for a given project by navigating to Preferences then
Filters as described below.

 1. Open Wordfast Pro and select a project from the project list.

 2. Click Open Project.

 3. Click Preferences under Options.

 4. Click Filters.

The Current or New Project filter options appear.

 5. To select the file filter settings for the open project, click a filter to list the current settings in the
Format Settings box.
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To add custom file filters, see Adding New File Filters.

Adding New File Filters

You can create a new filter based on one of the supported filters.

  Note:

Only file filters that appear in the list of filters can be modified into additional file filters with a new
Symbolic Name.

To add a new file filter:

 1. Open Wordfast Pro and select a project.

 2. Click Open Project on the Project List.

 3. Click Preferences under Options.

 4. Click Filters.
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The Configure source file filters appears listing Available filters.

 5. Click Add.
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The New Filter dialog box appears.

 6. Select the desired filter to use as a template for a new filter.

 7. Supply the information and make appropriate selections.

 8. Click OK to save the modified filter as a new filter.

User Preferences—Advanced Settings

The User Preferences comprise the Advanced Settings as follows:

• Restore a Wordfast Pro installation to Default Preferences Settings

• Export/Import Wordfast Pro Export/Import Preferences Settings

Default Preferences Settings

This Preferences option provides the means to restore the current preferences of a Wordfast Pro
installation to factory or default settings.

To restore Wordfast Pro to factory settings, navigate to Preferences then Advanced Settings as
described below.

 1. Open Wordfast Pro.

 2. Click Preferences under Options.
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The overall preferences setup panel appears.

 3. Click Advanced Settings.

The dialog box to restore, export, or import the current settings of a Wordfast Pro installation appears.

 4. In the Default Settings section, click:
• Restore Factory to revert this Wordfast Pro installation preferences to those of a new installation.

• Restore Defaults to revert this Wordfast Pro installation preferences to default preferences.

 5. Click OK to complete the restore process.

Export/Import Preferences Settings

This Preferences option provides the means to Import and Export the current preferences of the
Wordfast Pro installation.

 1. Open Wordfast Pro.

 2. Click Preferences under Options.

The overall preferences setup panel appears.

 3. Click Advanced Settings.
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The options to restore, export, or import the current settings of a Wordfast Pro installation appears.

 4. In the Export/Import Preferences Settings section, click:
• Export to save the current preferences for a given Wordfast Pro installation
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• Import to apply saved preferences

 5. Click OK to complete the Export/Import process.
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